 Basic Panels

___________________
Preface
1
___________________
Overview

SIMATIC HMI
HMI devices
Basic Panels

2
___________________
Safety instructions
3
___________________
Mounting and connecting
4
___________________
Operating the device
5
___________________
Configuring the HMI device

Operating Instructions

6
___________________
Commissioning a project
7
___________________
Maintenance and care
8
___________________
Technical specifications
A
___________________
Technical Support
B
___________________
Abbreviations

04/2012
A5E02421799-03

Legal information
Legal information
Warning notice system
This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are
graded according to the degree of danger.
DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.
WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.
CAUTION
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.
CAUTION
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.
NOTICE
indicates that an unintended result or situation can occur if the relevant information is not taken into account.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to
property damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific
task in accordance with the relevant documentation, in particular its warning notices and safety instructions.
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and
avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:
WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical
documentation. If products and components from other manufacturers are used, these must be recommended
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and
maintenance are required to ensure that the products operate safely and without any problems. The permissible
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the
information in this publication is reviewed regularly and any necessary corrections are included in subsequent
editions.

Siemens AG
Industry Sector
Postfach 48 48
90026 NÜRNBERG
GERMANY

A5E02421799-03
Ⓟ 04/2012 Technical data subject to change

Copyright © Siemens AG 2012.
All rights reserved

Preface
Purpose of the operating instructions
These operating instructions provide information based on the requirements defined by
IEC 62079 for documentation. This information relates to the HMI device, its storage,
transportation, place of use, installation, use and maintenance.
These operating instructions are intended for a variety of target groups. The following table
shows the chapters of these operating instructions that are of particular importance for the
respective target group.
Target group

Chapter

All

"Safety instructions"

Operators

"Overview"

The operator operates and monitors the system
during the process control phase.

"Operating a project"

Commissioning engineers

All chapters.

The commissioning engineer integrates the HMI
device into the system and ensures the operating
capability of the HMI device for the process control
phase.

Depending on the use of the HMI device,
certain chapters may not be of relevance to the
commissioning engineer, e.g. the section
"Maintenance and servicing."

Service technicians

All chapters.

Service technicians rectify faults that occur during
the process control phase.

Depending on the use of the HMI device,
certain chapters may not be of relevance to the
service technicians, e.g. the section
"Maintenance and servicing."

Maintenance technicians

Maintenance and care

Maintenance technicians carry out servicing and
maintenance work during the process control
phase.

The information system of WinCC flexible and WinCC contains further additional informaiton.
The information system is integrated as online help in WinCC flexible and WinCC and
contains instructions, examples and reference information in electronic form.

Basic Panels
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Scope
These operating instructions are valid for all SIMATIC HMI Basic Panels. The following
naming conventions apply:
Device designation

Device type

Interface type

Can be configured with

Keyboard unit

Basic Panel PN

WinCC (TIA Portal) as of V11

SIMATIC HMI
KP300 Basic mono PN
KP400 Basic color PN
KTP400 Basic mono PN
KTP400 Basic color PN

WinCC (TIA Portal) as of V11 SP2
Update 2 with HSP Basic 4" color
WinCC flexible and WinCC (TIA
Portal) as of V11

Touch device
with function
keys

WinCC (TIA Portal) as of V11 SP2
Update 2 with HSP Basic 4" color

KTP600 Basic mono PN
KTP600 Basic color DP

Basic Panel DP

KTP600 Basic color PN

Basic Panel PN

KTP1000 Basic color DP

Basic Panel DP

KTP1000 Basic color PN

Basic Panel PN

TP1500 Basic color PN

WinCC flexible and WinCC (TIA
Portal) as of V11

Touch device

In addition, the following collective designations are also used in these operating
instructions:
Designation

Covers the HMI devices

KTP400 Basic

KTP400 Basic mono PN, KTP400 Basic color PN

KTP600 Basic

KTP600 Basic mono PN, KTP600 Basic color DP, KTP600 Basic color PN

KTP1000

KTP1000 Basic color DP, KTP1000 Basic color PN

Basic knowledge required
Knowledge of automation technology and process communication is necessary to
understand the operating instructions.
An understanding of the use of computers and operating systems is also required.

Basic Panels
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Illustrations and text highlighting
This manual contains illustrations of the described devices. The illustrations may deviate
from the supplied device in certain details.
The following graphical highlighting facilitates reading these operating instructions:
Graphical highlighting

Description
If the instructions involve several tasks,
the individual tasks are highlighted by a
red number circle.



ื 0.2
Nm



A light blue highlight indicates
components and tools that are required
in the course of a task.
Safety instructions are highlighted by an
orange frame.
KTP600 Basic is sometimes shown in
the illustrations as a representation of all
Basic Panels.

.7

3



The following text highlighting facilitates reading these operating instructions:
Text highlighting

Scope

"Add screen"

•

Terms that appear in the user interface, for example, dialog
names, tabs, buttons, menu commands

•

Input values, for example, limits, tag values

•

Path information

"File > Edit"

Operational sequences, for example, menu commands, shortcut
menu commands

<F1>

Keyboard operation

Configuration and runtime software have different names as follows:
● "WinCC flexible 2008" or "WinCC (TIA Portal) V11", for example, refers to the
configuration software.
The term "WinCC flexible" or "WinCC" is used in a general context. The full name, for
example, "WinCC flexible 2008", is always used when it is necessary to differentiate
between different versions of the configuration software.
● "WinCC flexible Runtime" or "WinCC Runtime" refers to the runtime software that can run
on HMI devices.

Basic Panels
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Note information highlighted as follows:
Note
A note contains important information on described products and their handling or on a
section of this documentation.

Trademarks
Names labeled with a ® symbol are registered trademarks of the Siemens AG. Other names
used in this documentation may be trademarks, the use of which by third parties for their
own purposes could violate the rights of the owner.
● HMI®
● SIMATIC®
● SIMATIC HMI®
● WinCC®

Basic Panels
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Overview
1.1

Product Overview

Concentrating on the essentials - the new Basic Panels
Today, visualization is part of the standard repertoire for most machines. The cost factor
plays a crucial role in this case, especially for small machines and simple applications. HMI
devices with basic functions are often fully sufficient for simple applications.
This is exactly the demand that we intend to meet – with our new SIMATIC HMI Basic
Panels. By concentrating on the essentials, the Basic Panels offer exactly those basic
features that are demanded – at the right price. A perfect cost-to-performance ratio.
Like all devices in our product catalog, the new Basic Panels offer proven SIMATIC quality
and – regardless of their display dimensions – many software functions as standard: for
example, an alarm system, recipe management, trend functionality and language switching.
Users therefore profit from the advantages of visualization, such as improved process
quality, even with simple applications.
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1.2 Design of the KP300 Basic mono PN

1.2

Design of the KP300 Basic mono PN


















①
②
③
④
⑤

Power supply connector
PROFINET interface
Display
Control keys
Cutouts for a mounting clamp

⑥
⑦
⑧
⑨
⑩

Function keys
Rating plate
Mounting seal
Interface name
Functional earth connection
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1.3 Design of the KP400 Basic color PN

1.3

Design of the KP400 Basic color PN
















①
②
③
④

Cutouts for mounting clamps
Power supply connector
PROFINET interface

⑤
⑥
⑦

Function keys
Control keys
Data input keys

Display
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1.3 Design of the KP400 Basic color PN









①
②
③

Rating plate
Mounting seal

④
⑤

Functional earth connection
Guides for labeling strips

Interface name
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1.4 Design of the KTP400 Basic mono PN

1.4

Design of the KTP400 Basic mono PN














①
②
③
④
⑤

Power supply connector
Functional earth connection
PROFINET interface
Cutouts for a mounting clamp
Display/touch screen

⑥
⑦
⑧
⑨
⑩

Mounting seal
Guide for a labeling strip
Function keys
Rating plate
Interface name
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1.5 Design of the KTP400 Basic color PN

1.5

Design of the KTP400 Basic color PN
















①
②
③
④
⑤

Cutouts for mounting clamps
Power supply connector
PROFINET interface
Display/touch screen
Function keys

⑥
⑦
⑧
⑨
⑩

Guide for a labeling strip
Rating plate
Mounting seal
Interface name
Functional earth connection
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1.6 Design of the KTP600 Basic mono/color PN

1.6

Design of the KTP600 Basic mono/color PN



















①
②
③
④
⑤

Power supply connector
PROFINET interface
Cutouts for a mounting clamp
Display/touch screen
Mounting seal

⑥
⑦
⑧
⑨
⑩



Function keys
Rating plate
Interface name
Guide for a labeling strip
Functional earth connection
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1.7 Design of the KTP600 Basic color DP

1.7

Design of the KTP600 Basic color DP



















①
②
③
④
⑤
⑥

Power supply connector
RS-422/RS-485 interface
Cutouts for a mounting clamp
Display/touch screen
Mounting seal

⑦
⑧
⑨
⑩
⑪



Rating plate
Interface name
DIP switch
Guide for a labeling strip
Functional earth connection

Function keys
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1.8 Design of the KTP1000 Basic color PN

1.8

Design of the KTP1000 Basic color PN























①
②
③
④
⑤
⑥

Power supply connector
PROFINET interface
Cutouts for a mounting clamp
Display/touch screen
Mounting seal

⑦
⑧
⑨
⑩
⑪

Rating plate
Interface name
Fixing element
Functional earth connection
Guide for labeling strips

Function keys
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1.9 Design of the KTP1000 Basic color DP

1.9

Design of the KTP1000 Basic color DP
























①
②
③
④
⑤
⑥

Power supply connector
RS-422/RS-485 interface
Cutouts for a mounting clamp
Display/touch screen
Mounting seal
Function keys

⑦
⑧
⑨
⑩
⑪
⑫

Rating plate
DIP switch
Interface name
Fixing element
Functional earth connection
Guides for labeling strips
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1.10 Design of the TP1500 Basic color PN

1.10

Design of the TP1500 Basic color PN

















①
②
③
④
⑤

Power supply connector
PROFINET interface
Cutouts for a mounting clamp
Display/touch screen

⑥
⑦
⑧
⑨



Rating plate
Interface name
Fixing element
Functional earth connection

Mounting seal
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1.11 Product package

1.11

Product package
The following components are included in the product package of the HMI device.
Name

Figure

Quantity

HMI device

1

Quick Installation Guide

1

Mounting seal

1
Included with KTP 600 Basic and
already installed with all other
HMI devices.

Mounting clamps with
grub screw

Plastic mounting clamps

Aluminum mounting
clamps

Power supply terminal

4

KP300 Basic

7

KP400 Basic

5

KTP400 Basic color PN

5

KTP400 Basic mono PN

6

KTP600 Basic

12

KTP1000 Basic

14

TP1500 Basic

1

Basic Panels
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1.12 Accessories

1.12

Accessories
Accessories are not included in the product package of the HMI device, but can ordered on
the Internet under Industry Mall (http://mall.automation.siemens.com).
This section contains the number of accessories available at the time of publication of the
operating instructions.

Converters, adapters and connectors

1

Name

Purpose

Order no.

RS 422 to RS 232
converter

Connection of third-party controllers to Basic
Panels DP

6AV6671-8XE00-0AX0

PC/PPI cable

Converts RS 422/RS 485 signals to RS 232
signals. Is required for updating the operating
system with reset to factory settings 1. Can also
be used for the transfer.

6ES7 901-3CB30-0XA0

90 degree elbow
adapter

For RS422/RS485 interface, cable outlet to rear 6AV6671-8XD00-0AX0

USB/PPI cable

Converts RS 422/RS 485 signals to USB
signals. Is required for updating the operating
system with reset to factory settings. Can also
be used for the transfer.

6ES7 901-3DB30-0XA0

PROFIBUS connector

Recommended PROFIBUS connector with
straight cable outlet

6GK1500-0FC10

PROFINET RJ45
connector "IE FC RJ45
Plug 2x2"

Required for connection of Basic Panels PN to
PROFINET

6GK1901-1BB10-2AA0

If the connection is lost during the operating system update, set a lower bit rate. If you use a higher
bit rate, you must use the PC/PPI cable release 3 or higher. The release code is printed on the
cable ("E version 3," for example, corresponds to release 3).

Clamping frame
Name

Purpose

Order no.

Clamping frame
for 10"/12" Touch

For reinforcement of the mounting cutout for
KTP1000 Basic when material is not thick
enough

6AV6 671-8XS00-0AX0

Basic Panels
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1.13 Commissioning the HMI device

Protective foil
Name

Purpose

Order no.

Protective foil 4"

Protective foil set for KTP400 Basic mono PN

6AV6 671-2EC00-0AX0

Protective foil 4"
widescreen

Protective foil set for KTP400 Basic color PN

6AV2124-6DJ00-0AX0

Protective foil 6"

Protective foil set for KTP600 Basic

6AV6 671-2XC00-0AX0

Protective foil 10"

Protective foil set for KTP1000 Basic

6AV6 671-3DC00-0AX5

Protective foil 15"

Protective foil set for TP1500 Basic color PN

6AV6 574-1AD00-4EX0

Service packages

1.13

Purpose

Order no.

Set with 20 plastic clamps for KP300 Basic Mono PN, KP400 Basic color
PN and KTP400 Basic color PN

6AV6671-8KX00-0AX2

Set with 20 aluminum mounting clamps for Basic Panels from 4"

6AV6671-8XK00-0AX0

Set of 10 power supply terminals

6AV6671-8XA00-0AX0

Commissioning the HMI device
This section contains an overview of the tasks required for commissioning the HMI device.
Description

Section

1.

Familiarize yourself with the safety
instructions.

Safety instructions (Page 25)

2.

Prepare the HMI device for mounting.

Preparations (Page 29)

3.

Install the HMI device.

Mounting the HMI device (Page 34)

4.

Connect the equipotential bonding.

Connecting the equipotential bonding circuit
(Page 38)

5.

Connect the power supply.

Connecting the power supply (Page 39)

6.

Connect a configuration PC.

Connecting the configuration PC (Page 42)

7.

Enable sharing for data channel on the HMI
device.

Enabling a data channel (Page 76)

8.

Transfer a project.

Starting manual transfer (Page 91)

9.

After transferring the project, disconnect the
HMI device from the configuration PC and
connect the HMI device to the PLC.

Connecting the PLC (Page 45)

Basic Panels
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Safety instructions
2.1

2

General safety instructions

Working on the control cabinet
WARNING
Open equipment
The HMI device is open equipment. That means that the HMI device may only be installed
in cubicles or cabinets that provide front panel access for operating the device.
The cubicle or cabinet in which the HMI device is installed may only be accessed with a key
or tool and only by trained, authorized personnel.
Dangerous voltage
Opening the cabinet will expose high voltage parts. Contact with these parts could be fatal.
Always disconnect the cabinet from the mains before opening it.

High frequency radiation
NOTICE
Unwanted operating states
High-frequency radiation, for example, from cellular phones, can trigger unwanted
operating states.

Installation as intended
WARNING
Installation only in machinery that conforms to the machinery directive
It is not allowed to commission the HMI device unless it has been verified that the machine
in which the HMI device is to be installed complies with Directive 2006/42/EC.
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2.2 Security information

2.2

Security information
Siemens offers IT security mechanisms for its portfolio of automation and drive products in
order to support safe operation of the plant/machine. We recommend that you stay informed
about the IT security developments for your products. For information on this topic, refer to:
Industry Online Support (http://www.siemens.de/automation/csi_en_WW): You can register
for a product-specific newsletter here.
For the safe operation of a plant/machine, however, it is also necessary to integrate the
automation components into an overall IT security concept for the entire plant/machine,
which corresponds to the state-of-the-art IT technology. You can find information on this
under: Industrial Security (http://www.siemens.com/industrialsecurity).
Products used from other manufacturers should also be taken into account here.

2.3

Notes about usage
CAUTION
HMI device approved for indoor use only
The HMI device may be damaged if operated outdoors.
Operate the HMI device indoors only.

Industrial applications
The HMI device is designed for industrial applications. It conforms to the following standards:
● Requirements of the emission standard for industrial environments, EN 61000-6-4: 2007
● ESD immunity requirements to DIN EN 61000-6-2:2005
Use in residential areas
Note
The HMI device is not intended for use in residential areas. Operation of an HMI device in
residential areas can have a negative influence on radio/TV reception.
If the HMI device is used in a residential area, you must take measures to achieve Limit
Class B conforming to EN 55011 for RF interference.
A suitable measure for achieving the RF interference level to Limit Class B is, for example,
the use of filters in power supply lines.
Individual acceptance is required.
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Notes on communication
NOTICE
Communication errors caused by address conflict
Communication errors can occur if several devices in a network share the same bus
address or IP address.
Make sure that your HMI device is assigned a unique address in the network.
Note
Updating tag values following a communication error
If communication between an HMI device and PLC is interrupted, all tag values displayed on
the HMI device will be replaced by a hash mark ("#").
When the communication between the HMI device and PLC is restored, all tag values will be
updated immediately. The cycle time for updating the tag values begins again at "0."
Ethernet communication with Basic Panels PN
Basic Panels PN support the following types of communication:
• PROFINET basic function for commissioning and diagnostics
• Standard Ethernet communication

Basic Panels
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Mounting and connecting
3.1

Preparations

3.1.1

Checking the package contents

3

Check the package content for visible signs of transport damage and for completeness.
NOTICE
Damaged parts
Do not install parts damaged during shipment. In the case of damaged parts, contact your
Siemens representative.
The package content is described in section Product package (Page 22).
Keep the supplied documentation in a safe place. The documentation belongs to the HMI
device and is required for subsequent commissioning.

3.1.2

Checking the operating conditions
Note the following aspects before installing the HMI device:
1. Familiarize yourself with the standards, approvals, EMC parameters and technical
specifications for operation of the HMI device. This information is available in the
following chapters:
– Certificates and approvals (Page 117)
– Electromagnetic compatibility (Page 118)
– Information on insulation tests, protection class and degree of protection (Page 140)
– Power supply (Page 131)
2. Check the mechanical and climatic ambient conditions for operation of the HMI device;
see Conditions of use (Page 138).

3.1.3

Selecting a mounting position
Select one of the approved mounting positions for your HMI device. The approved mounting
positions are described in the following sections.
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Mounting and connecting
3.1 Preparations

Horizontal mounting position
All Basic HMI devices are suitable for
horizontal mounting positions.
The maximum ambient temperature at
the device with vertical mounting in
horizontal positions is 50 °C

The following Basic HMI devices are
also suitable for vertical mounting
positions:
•

KTP400 Basic

• KTP600 Basic
The maximum ambient temperature at
the device with vertical mounting in
vertical positions is 40 °C

Angled mounting position
The Basic HMI devices are selfventilating. Vertical and angled
mounting is permitted in:

50 °C
0 °C
rದr

rದr

40 °C
0 °C

40 °C
0 °C

•

Mounting cabinets

•

Control cabinets

•

Switchboards

•

Consoles

CAUTION
Exceeding the ambient temperature
Forced ventilation is required if the maximum permitted ambient temperature for operating
the HMI device is exceeded. The HMI device can otherwise be damaged and its approvals
and warranty will be void.

See also
Conditions of use (Page 138)
Basic Panels
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Mounting and connecting
3.1 Preparations

3.1.4

Checking clearances
The following clearances are required around the HMI device to ensure sufficient selfventilation:

All Basic
Panels

x

y

y

KTP400 Basic
KTP600 Basic

All dimensions in mm

x

z

z
x
x
y
y

3.1.5

Required clearance around the HMI
devices.

x

y

z

.3%DVLF







.3%DVLF







.73%DVLF







.73%DVLF







.73%DVLF







73%DVLF







Making the mounting cut-out
NOTICE
Stability of the mounting cutout
The material in the area of the mounting cutout must provide sufficient strength to
guarantee the enduring and safe mounting of the HMI device.
The force of the mounting clamps or operation of the device may not lead to deformation of
the material in order to achieve the degrees of protection described below.

Degrees of protection
The degrees of protection of the HMI device can only be guaranteed if the following
requirements are met:
● Material thickness at the mounting cutout 2 mm to 6 mm for IP65 degree of protection or
Front face only Type 4X/Type 12 (indoor use only) degree of protection. The thickness is
2 mm to 4 mm for the KP300 Basic mono PN.
● Permitted deviation from plane at the mounting cutout: ≤ 0.5 mm
This condition must be fulfilled for the mounted HMI device.
● Permissible surface roughness in the area of the seal: ≤ 120 µm (Rz 120)
A clamping frame is additionally available for the HMI device KTP1000 Basic with a material
thickness < 2 mm at the mounting cutout. The frame enables you to achieve degree of
protection IP65 or Front face only Type 4X/Type 12.

Basic Panels
Operating Instructions, 04/2012, A5E02421799-03

31

Mounting and connecting
3.1 Preparations

Mounting compatibility
The mounting cutouts of the Basic panels are compatible with the mounting cutouts of the
following SIMATIC HMI devices:
Mounting cutout for the Basic
Panel

Compatible to the mounting cutouts of the HMI device

KP400 Basic

OP77A, OP77B

KTP400 Basic

TP 177B 4"

KTP600 Basic

TP 177 A, TP 177B 6", TP 177micro

KTP1000 Basic

MP 277 10" Touch, MP 377 12" Touch

TP1500 Basic

MP 377 15" Touch, Thin Client 15" Touch

Dimensions of the mounting cutout
Dimensions of the mounting cutout for the
basic HMI devices in horizontal mounting position:

w

w
h

+1
0

h

+1
0

.3%DVLF





.3%DVLF





.73%DVLF





.73%DVLF





.73%DVLF





73%DVLF





Dimensions of the mounting cutout for the
basic HMI devices in vertical mounting position:
+1
0

h

.73%DVLF





.73%DVLF





w

+1
0

All dimensions in mm

See also
Accessories (Page 23)
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Mounting and connecting
3.1 Preparations

3.1.6

Labeling the function keys
The KP300 Basic has no function keys that can be labeled.
Note
Do not write on the keyboard to label the function keys.
Any printable and writable foil can be used as labeling strip. The permitted thickness of the
labeling strip is 0.15 mm. Paper labeling strips are inappropriate.
1. Edit the template on the PC.

A









The template is available in the
"CD_3\Documents\
<language>\Slides" directory on the
WinCC/WinCC flexible DVD or on
the Internet at:

PLQ

Downloads for Basic Panels
(http://support.automation.siemens.c
om/WW/view/en/28426379/133100)
2. Print the edited template on foil.
3. Apply a fixing spray film to the
labeling strips.
4. Wait approx. 5 minutes until the
fixing spray is dry and smear-proof.



5. Cut out the labeling strip.



6. Cut off the corners of the labeling
strips at an angle of 45° to make it
easier to insert them.
7. Slide the labeling strips into the slot
up to the end of the guide.
The labeling strips will protrude
approximately 3 cm out of the guide.
The template dimensions for the
labeling strips are designed so that
the labeling is correctly placed for
the function keys. It is not necessary
to secure the labeling strip.

.7
3
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3.2 Mounting the HMI device

3.2

Mounting the HMI device

Required tools and accessories
Slotted screwdriver, size 2

Mounting clamp type

For HMI device

Aluminum mounting clamps

KTP400 Basic mono

5

KTP600 Basic

6

KTP1000 Basic

12

Plastic mounting clamps

Required quantity

TP1500 Basic:

14

KP300 Basic

4

KP400 Basic

7

KTP400 Basic color

5

Inserting the HMI device
1. If necessary, insert the mounting
seal in the groove on the back of the
HMI device front panel.

,3

Make sure that the mounting seal is
not twisted. A correctly inserted
mounting seal is required to ensure
IP65 degree of protection.



2. Insert the HMI device into the
mounting cutout from the front.
Ensure that the protruding labeling
strips are not caught between the
mounting cutout and HMI device.
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3.2 Mounting the HMI device

Securing the HMI device with aluminum mounting clamps
1. Insert the first clamp at the first
position of the cutouts on the back of
the HMI device.



ื 0.2
Nm



Set the clamp positions for your HMI
device to match those of the figures
in the following table row.
2. Secure the clamps using a size 2
screwdriver. The maximum
permitted torque is 0.2 N/m.
3. Repeat steps 1 to 2 for all mounting
clamps required to secure your HMI
device.

.7

ದ

3



ದ

ದ

ದ

ದ

ದ
.73
%DVLFPRQR

.73%DVLF
ದ

ದ

ದ

ದ

ದ
ದ

ದ

ದ

ದ
ದ

ದ

73%DVLF
ದ

ದ

.73%DVLF

ದ
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Mounting and connecting
3.3 Connecting the HMI device

Securing the HMI device with plastic mounting clamps
1. If mounting clamps and grub screws
are available separately in the
accessories bag, insert a grub screw
into the mounting clamp bore hole
and turn it several times.



2. Place the first mounting clamp into
the corresponding cutout.
3. Secure the clamps using a size 2
screwdriver. The maximum
permitted torque is 0.2 N/m.



ื 0.2
Nm



.7

3


4. Repeat steps 1 to 3 for all mounting
clamps required to secure your HMI
device.



3.3

Connecting the HMI device

3.3.1

Connection sequence

Required tools and accessories
Before beginning the connection of the HMI device, have the following tools and accessories
at hand:
Slotted screwdriver, size 2

Phillips screwdriver, size 3
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Mounting and connecting
3.3 Connecting the HMI device
Torx screwdriver, size TX20

Crimp pliers

Power supply terminal

24 VDC with sufficient amperage.
See Specifications (Page 131)

Procedure
Keep to the following sequence of tasks when connecting the HMI device:
1. Connecting the equipotential bonding circuit (Page 38)
2. Connecting the power supply (Page 39)
3. Connecting the configuration PC (Page 42)
4. Connecting the PLC (Page 45)
NOTICE
Strain relief
Contacts can be broken or wires can be torn off if cables are not provided adequate
strain relief.
Provide adequate strain relief for all cables.

See also
Securing the cables (Page 50)
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3.3 Connecting the HMI device

3.3.2

Connecting the equipotential bonding circuit

Differences in electrical potential
Differences in electrical potential can develop between spatially separated plant
components. Such electrical potential differences can lead to high equalizing currents over
the data cables and therefore to the destruction of their interfaces. Equalizing currents can
develop if the cable shielding is terminated at both ends and grounded to different plant
parts.
Differences in potential may develop when a system is connected to different mains
supplies.

General requirements for equipotential bonding
Differences in potential must be reduced by means of equipotential bonding in order to
ensure trouble-free operation of the relevant components of the electronic system. The
following must therefore be observed when installing the equipotential bonding circuit:
● The effectiveness of equipotential bonding increases as the impedance of the
equipotential bonding conductor decreases or as its cross-section increases.
● If two plant parts are interconnected by means of shielded data cables and their shielding
is bonded at both ends to the grounding/protective conductor, the impedance of the
additionally installed equipotential bonding cable must not exceed 10% of the shielding
impedance.
● The cross-section of an equipotential bonding conductor must be capable of handling the
maximum equalizing current. The best practical results for equipotential bonding between
two cabinets have been achieved with a minimum conductor cross-section of 16 mm².
● Use equipotential bonding conductors made of copper or galvanized steel. Establish a
large surface contact between the equipotential bonding conductors and the
grounding/protective conductor and protect these from corrosion.
● Clamp the shielding of the data cable on the HMI device flush and near the equipotential
rail using suitable cable clamps.
● Route the equipotential bonding conductor and data cables in parallel and with minimum
clearance between these.
NOTICE
Equipotential bonding cable
Cable shielding is not suitable for equipotential bonding. Always use the prescribed
equipotential bonding conductors. The cross-section of the equipotential bonding
conductor must not be less than 16 mm². Always use cables with an adequate crosssection when installing MPI and PROFIBUS DP networks. The interface modules may
otherwise be damaged or destroyed.
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3.3 Connecting the HMI device

Procedure
1. Interconnect functional ground of the
HMI device with an grounding cable,
cross-section 4 mm2.



.7
3



2. Connect the grounding cable of the
HMI device to the equipotential
bonding rail.



PPt

ุPPt

ุPPt

352),%86
352),1(7

3.3.3

Connecting the power supply

Stripping the cable


6m

m



Use power supply cables with a
maximum cross-section of 1.5 mm2.
1. Strip the ends of two power supply
cables to a length of 6 mm.
2. Attach cable sleeves to the bare
cable ends.



3. Fix the cable sleeve onto the cable
ends using the crimp pliers.
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3.3 Connecting the HMI device

Procedure
CAUTION
24 VDC only
An incorrectly dimensioned power supply can lead to destruction of the HMI device.
Use a 24 VDC power supply with adequate amperage; see Specifications (Page 131).

1. Insert the two power cables into the
mains terminal and secure them with
a slotted screwdriver.
2. Connect the HMI device to the
mains terminal.

.7
3

3. Switch off the power supply.



4. Insert the two remaining cable ends
into the power terminals and secure
them with the slotted screwdriver.



Ensure correct polarity.




2))


M
L+
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Mounting and connecting
3.3 Connecting the HMI device

3.3.4

Connecting a programming device
A programming device provides the following options:
● Transferring projects.
● Transferring device images.

Connecting a programming device to a Basic Panel DP
Note
A programming device cannot be used to reset the HMI device to factory settings.

1. Shut down the HMI device. Make
sure that the DIP switch on the rear
panel of the HMI device is in the
position shown.

   



21
2))

RS 422/ 485


PROFIBUS

2. Connect an RS 485 PROFIBUS
connector to the HMI device.
3. Connect an RS 485 PROFIBUS
connector to the programming
device.



RS 485

PG
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3.3 Connecting the HMI device

3.3.5

Connecting the configuration PC
A configuring PC provides the following options:
● Transferring projects.
● Transferring device images.
● Resetting HMI device to factory settings.

Connecting a configuring PC to a Basic Panel DP
1. Shut down the HMI device.
2. Connect the RS 485 connector of
the PC/PPI cable to the HMI device.


2))

RS422/485

3. Connect the RS 232 connector of
the PC/PPI cable to the configuring
PC.



You can also use the USB/PPI cable
from the accessories instead of the
PC/PPI cable.

Serial


RS 232

You can find ordering information in the
Accessories (Page 23) section.

PC
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Mounting and connecting
3.3 Connecting the HMI device

Configuring the PC/PPI cable
Configure the transmission speed using the DIP switches of the PC/PPI cable if using the
PC/PPI cable to interconnect the HMI device with the configuring PC.
Note
Set a lower bit rate if the connection is lost during the operating system update. If you use a
higher bit rate, you must use the PC/PPI cable release 3 or higher. The version code is
printed on the cable ("E stand 3," for example, corresponds to release 3).

Set the DIP switches 1 to 3 to the same
value as in WinCC flexible or WinCC.
DIP switches 4 to 8 must be set to "0".
In the figure, the bit rate is set to
115.2 kbps.



       

You can set the following bit rates:
Bit rate in kbps

DIP switch 1

DIP switch 2

DIP switch 3

115.2

1

1

0

57.6

1

1

1

38.4

0

0

0

19.2

0

0

1

9.6

0

1

0

4.8

0

1

1

2.4

1

0

0

1.2

1

0

1
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3.3 Connecting the HMI device

Connecting a configuring PC to a Basic Panel PN
CAUTION
Data network security for communication via Ethernet
With Ethernet-based communication via PROFINET, the end user is himself responsible for
the security of his data network; the proper functioning of the data network cannot be
guaranteed in all circumstances, for example in the case of target attacks leading to an
overloading of the device.
NOTICE
RJ45 plug connector with 180° output required
The connection of the Basic Panels PN to the HMI device requires the RJ45 plug connector
"IE FC RJ45 Plug 2 x 2". You can find ordering information in the Accessories (Page 23)
section.
Use a standard CAT-5 Ethernet cable to connect the configuring PC.
1. Shut down the HMI device.
2. Connect one RJ45 connector of the
LAN cable to the HMI device.


2))

PROFINET (LAN)

3. Connect the other RJ45 connector of
the LAN cable to the configuring PC.



LAN


LAN

PC

See also
Data transmission options (Page 91)
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3.3 Connecting the HMI device

3.3.6

Connecting the PLC
If the HMI device contains an operating system and an executable project, connect the HMI
device to the PLC.
Note
Note the following when connecting the PLC to a panel:
• Lay the data lines parallel to the equipotential bonding conductors
• Connect the shields of the data lines to the ground

Connecting a PLC to a Basic Panel DP
You can connect Basic Panels DP via
the RS 422/RS 485 interface to the
following SIMATIC PLCs:

RS 422/485

PROFIBUS

DP

SIMATIC S7-200
SIMATIC S7-300/400

RS 422/485

Serial

RS 232

•

SIMATIC S7-200

•

SIMATIC S7-300/400

•

SIMATIC S7-1200

You can interconnect Basic Panels DP
with the following PLCs via converter
(from the accessories):
•

Modicon Modbus

• Allen Bradley DF1
For ordering information for the
converters, refer to chapter Accessories
(Page 23).
If using the RS 422/RS 485 port, read
the notes on configuration in the
following section.

Third party PLC
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3.3 Connecting the HMI device

Configuring an RS422/RS485 port
A DIP switch for the configuration of the RS422/RS485 interface is located on the back of the
HMI device.
The DIP switch is set at the factory to enable communication with the SIMATIC PLC via
RS 485.
Note
Note the diagrams of DIP switch settings on the rear panel of the HMI device.
The following table shows the DIP switch settings. The send and receive direction is toggled
internally using the RTS signal.
Communication
DP/MPI/PPI

Switch setting
   
21

Meaning
No RTS signal on connector, for data exchange between
the SIMATIC PLC and the HMI device
(factory state)
RTS signal on pin 4, same as PLC,
for example, for commissioning

   
21

RTS signal on pin 9, same as for a programming device,
for example, for commissioning

   
21

RS 422/RS 485

RS 422/RS 485 interface is active, for example, for
connecting PLCs of other manufacturers

   
21
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3.3 Connecting the HMI device

Connecting the PLC to a Basic Panel PN
CAUTION
Data network security for communication via Ethernet
With Ethernet-based communication via PROFINET, the end user is himself responsible for
the security of his data network; the proper functioning of the data network cannot be
guaranteed in all circumstances, for example in the case of target attacks leading to an
overloading of the device.
NOTICE
RJ45 plug connector with 180° output required
The connection of the Basic Panels PN to the HMI device requires the RJ45 plug connector
"IE FC RJ45 Plug 2 x 2". You can find ordering information in the Accessories (Page 23)
section.
Basic Panels PN can be connected to
the following SIMATIC PLCs:
•

SIMATIC S7-200

•

SIMATIC S7-300/400

SIMATIC S7 with PROFINET
interface
The connection is set up via
PROFINET/LAN.
•

PROFINET (LAN)

PROFINET

PROFINET
LAN

SIMATIC S7-200
SIMATIC S7-300/400
SIMATIC S7-1200

See also
Connecting the equipotential bonding circuit (Page 38)
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Mounting and connecting
3.4 Switching on and testing the HMI device

3.4

Switching on and testing the HMI device

Switching on the HMI device.
Switching on the power supply.
The screen lights up after power is switched on.
A progress bar is displayed during startup.
If the HMI device fails to start, you have probably
crossed the wires on the power supply terminal.
Check the connected wires and change their
connection.

.7
3
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Mounting and connecting
3.4 Switching on and testing the HMI device
The Loader opens after the operating system has started.
● Touch devices: You operate the loader via the buttons on the touch screen
● Key devices: You use the cursor keys to operate the loader menu. You use the
<ENTER> key to execute a menu command or switch to a submenu.
•

Press the "Transfer" button or use the "Transfer"
menu command to set the HMI device to "Transfer"
mode.
The transfer mode can only be activated when at
least one data channel has been enabled for the
transfer.

•

Press the "Start" button or use the "Start" menu
command to start the project on the HMI device.
If you do not perform an operation, the project on the
HMI device will automatically start after a delay.

•

<Loader version>
Transfer
Start
Info/Settings

Press the "Control Panel" button or use the
"Info/Settings" menu command to open the Control
Panel of the HMI device.
You can change various settings in the Control Panel,
for example, the transfer settings.

Shutting down the HMI Device
1. Close any active projects on the HMI device.
2. Shut down the HMI device. You have the following shutdown options:
– Switch off the power supply.
– Remove the power supply terminal from the HMI device.
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3.5 Securing the cables

3.5

Securing the cables
The following HMI devices come equipped with a fixing element on the back for strain relief:
● KTP1000 Basic DP
● KTP1000 Basic PN
● TP1500 Basic

After the power-on test, use a cable tie to secure the connected cables to the marked fixing
element in order to provide strain relief.
On the back of the HMI device KP400 Basic color PN, there are openings for leading in two
cable ties for strain relief of the power supply cable and LAN cable.
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Operating the device
4.1

Operating touch devices

4.1.1

Overview

4

Most Basic HMI devices feature a touch screen. Certain Basic HMI devices feature function
keys. Use the touch screen and function keys to operate the Control Panel or the project
running on your HMI device.
DANGER
Incorrect operation
A project can contain certain operations that require in-depth knowledge about the specific
plant on the part of the operator.
Ensure that only trained professional personnel operate the plant.

Operating the touch screen
CAUTION
Damage to the touch screen
Pointed or sharp objects can damage the plastic surface of the touch screen.
Operate the touch screen only with your fingers or with a touch pen.
Triggering unintended actions
Touching several operating elements at the same time can trigger unintended actions.
Touch only one operating element on the screen at a time.
Operating elements are touch-sensitive symbols on the screen of the HMI device.
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Operating the device
4.1 Operating touch devices
They are basically operated in the same way as mechanical keys. You activate operating
elements by touching them with your finger.
Note
The HMI device returns a visual feedback as soon as it detects that an operating element
has been touched.
The visual feedback is independent of any communication with the PLC. The visual feedback
signal therefore does not indicate whether or not the relevant action is actually executed.
Examples of operating elements:
● Buttons
Buttons can assume the following states:
"Untouched"

"Touched"

● Invisible buttons
The focus of invisible buttons is by default not indicated following selection. No optical
operation feedback is provided in this case.
The configuration engineer may, however, configure invisible buttons so that their outline
appears as lines when touched. This outline remains visible until you select another
operating element.
● I/O fields
A screen keyboard appears as visual feedback after you touched an I/O field, for
example, to enter a password.
Depending on the HMI device and the configured operating element, the system displays
different screen keyboards for entering numerical or alphanumerical values.
The screen keyboard is automatically hidden again when input is complete.
Note
Description of all operating elements
A comprehensive description of all operating elements for your HMI device is provided in
"Display and operating elements" section of the WinCC flexible and WinCC Online Help.

Basic Panels

52

Operating Instructions, 04/2012, A5E02421799-03

Operating the device
4.1 Operating touch devices

Operating function keys
The function keys can be assigned global or local functions:
● Function keys with global function assignment
A function key with global function assignment always triggers the same action on the
HMI device or in the PLC, regardless of the currently displayed screen. An example of
such an action is the activation of a screen, or the closing of an alarm window.
● Function keys with local function assignment
A function key with local function assignment is screen-specific and is therefore only
effective within the active screen.
The function assigned to a function key can vary from screen to screen.
The function key can be assigned only a single function, either global or local, within a
screen. Local function assignments override global function assignments.

4.1.2

General functions of the screen keyboard
The following keys are available on the screen keyboard of all Basic HMI devices with touch
functionality:
Cursor left

Cursor right

Delete character

Cancel input

Confirm input

Displaying infotext. This key only appears when an infotext has been configured for the
operating element.
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4.1.3

Entering data on the KTP400 Basic
Due to the small display, the screen keyboard and the input concept of the KTP400 Basic
differs compared to other Basic HMI devices.

7H[W

7H[W
681

,FRQV

1XPEHUV
681

681

The screen keyboard appears on the HMI device touch screen when you touch an operating
element that requires input.
The screen keyboard of the KTP400 BASIC features four views. You can change the view
while making entries using the buttons in the fourth row of the screen keyboard:
Key

Changes to the view
Entering text, characters "A" to "M"

Entering text, characters "N" to "Z"

Entering numbers, "0" to "9," signed or unsigned and with or without decimal places

Entering special characters

Entering text, shift to lower case letters
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Note
Job mailbox has no effect
PLC job 51 "Select screen" has no effect while the screen keyboard is open.
Key assignment
The alphanumerical screen keyboard layout is monolingual.
A language change within the project has no effect on the layout of the alphanumerical
screen keyboard.

Entering alphanumerical values


1. Touch the desired operating element on the
screen.
The alphanumerical screen keyboard opens.
2. Enter the value. Depending on the settings,
the HMI device outputs an audible signal.
You can change the view of the screen
keyboard using the keys <N-Z> and <A-M>.
Use the <Shift> key to enter lower-case
letters.



3. Press <Return> key to confirm your entries, or
cancel them with <ESC>.
Either action closes the screen keyboard.
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Entering numerical values
1. Touch the desired operating element on the
screen.




The numerical screen keyboard opens.
2. Enter the value. Depending on the settings,
the HMI device outputs an audible signal.



You can change the view of the screen
keyboard for entering numbers with
hexadecimal notation using the <N-Z> and
<A-M> keys.
3. Press <Return> key to confirm your entries, or
cancel them with <ESC>.
Either action closes the screen keyboard.

Checking numerical value limits
Tags can be assigned limit values. Any entry of a value outside this limit is rejected. If an
alarm view is configured, a system event is triggered and the original value is displayed
again.

Decimal places of numerical values
The configuration engineer can define the number of decimal places for a numerical text box.
The number of decimal places is checked when you enter a value in this type of I/O field.
● Decimal places that exceed the limit are ignored.
● Unused decimal places are padded with "0" entries.
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4.1.4

Entering data on the KTP600 Basic, KTP1000 Basic , TP1500 Basic

Alphanumerical screen keyboard
The screen keyboard appears on the HMI device touch screen when you touch an operating
element that requires input.

7H[W

1XPEHUV
681

))))

Note
Job mailbox has no effect
PLC job 51 "Select screen" has no effect while the screen keyboard is open.
Key assignment
The alphanumerical screen keyboard layout is monolingual.
A language change within the project has no effect on the layout of the alphanumerical
screen keyboard.

Entering alphanumerical values
1. Touch the desired operating
element on the screen.



The alphanumerical screen
keyboard opens.
2. Enter the value. Depending on
the settings, the HMI device
outputs an audible signal.
Use the <Shift> key to enter
lower-case letters.



3. Press <Return> key to confirm
your entries, or cancel them with
<ESC>.
Either action closes the screen
keyboard.
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Entering numerical values
1. Touch the desired operating
element on the screen.


The numerical screen keyboard
opens.



2. Enter the value. Depending on
the settings, the HMI device
outputs an audible signal.
3. Press <Return> key to confirm
your entries, or cancel them with
<ESC>.
Either action closes the screen
keyboard.



Checking numerical value limits
Tags can be assigned limit values. Any entry of a value outside this limit is rejected. If an
alarm view is configured, a system event is triggered and the original value is displayed
again.

Decimal places of numerical values
The configuration engineer can define the number of decimal places for a numerical text box.
The number of decimal places is checked when you enter a value in this type of I/O field.
● Decimal places that exceed the limit are ignored.
● Unused decimal places are padded with "0" entries.
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4.2

Operating KP300 Basic

4.2.1

Overview
The KP300 Basic comes equipped with system keys. The system keys are as follows:
● Control keys
● Function keys with integrated alphanumeric keys

Control keys
The following table shows the function and effect of the control keys of the HMI device:
Key

Function

Effect

Moving the cursor

Operating elements: Activates the next operating element in
the respective direction
Input: Moves the cursor in the respective direction
List: Selects the next list entry.

(17(5

Confirming or
activating

Menu: Executes the selected command.
Input: Confirms and ends the entry.
List: Activates the operation.

Cancels the action
(6&

Value entry: Restores the original value.
Window: Closes the window without applying a change.
Help: Closes the Help and returns to the previous view.

Acknowledge alarm

Depending on the configuration, acknowledges the
currently displayed or selected message or all messages of
an acknowledgment group.

Delete characters

Deletes the character at the cursor position. The following
characters are moved one position to the left.

Displaying infotext

Shows the selected configured infotext for the selected
operating element. No Help is displayed if no infotext is
configured.

Toggle between
upper-case and
lower-case

Toggles the text entry between upper-case and lower-case.
The subsequent characters are then written either in upper
or lower case.

Activate next
operating element

Activates the next operating element within the configured
TAB order within the project.

$&.
(6&

'(/

US

+(/3
)
nopUS

T

7$%
Vh

T

7$%
Vh
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Operating function keys
The function keys can be assigned global or local functions:
● Function keys with global function assignment
A function key with global function assignment always triggers the same action on the
HMI device or in the PLC, regardless of the currently displayed screen. An example of
such an action is the activation of a screen, or the closing of an alarm window.
● Function keys with local function assignment
A function key with local function assignment is screen-specific and is therefore only
effective within the active screen.
The function assigned to a function key can vary from screen to screen.
The function key can be assigned only a single function, either global or local, within a
screen. Local function assignments override global function assignments.
NOTICE
Function keys are disabled during keyboard input
When you enter values using the keyboard, the function key assignment is disabled.
Take this information into account in your configuration.
Use the integrated alphanumeric keys for data input as described in the subsection below.

4.2.2

Entering data on the KP300 Basic

Introduction
The function keys of the KP300 Basic have the same operating concept as a cell phone
keypad. Each function key assigned with several letters and symbols of the alphabet and
each is assigned a number. The available ones are displayed in a menu on the display when
you enter values. The selection in the menu moves one position to the right every time the
function key is pressed. At the end, the selction resumes again at the start.
The numerical and alphanumerical assignment alway has the following order for value entry:
1. Letters, for example JKL
2. Numers, for example 5
3. Special characters and umlauts (optional)
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The following figure shows the assignment using the "F5" function key as an example.


)



-./

①
②

③




Number assignment; automatically active when you enter numerical values
Function key assignment; active by default
If you change to editing mode in the Control Panel or project with <ENTER>, the function
assignment is disabled. Instead, the numerical and/or alphanumerical assignment is active. A
message indicating that the function keys are disabled appears at the same time.
Letter assignment; automatically active when you enter alphanumerical values. The numerical
assignment is available as well.
When you enter hexadecimal values, the alphanumerical assignment from "A" to "F" and the
numerical assignment are active.

On the KP300 Basic, you navigate either in the menu or operate the current project.

Operating Menus
Proceed as follows:
1. Use the cursor keys to navigate within the menu of the KP300 Basic.
The selection moves to the corresponding menu entry.
2. Press <ENTER> to execute a menu command.
The next menu level is displayed.
3. If the menu level contains an text box, use the function keys to enter the appropriate
value.
4. If the menu level contains a list:
– Press <ENTER> to activate the operation of the list.
– Use the cursor keys to move between list entries.
– Press <ENTER> to execute a list entry.
5. To enter a value in the menu:
– Press <ENTER> to apply a value.
– Press <ESC> to discard a value or return to a higher-level menu.
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Operating a project
Proceed as follows:
1. To navigate between operating elements:
– Press <TAB> to navigate within a configured TAB order.
– Use the cursor keys to navigate freely between operating elements.
The operating element is selected.
2. Press <ENTER> to activate the operation of a selected operating element.
– Depending on the operating element, enter values or select them from the available
list entries.
3. To close the operation of an operating element:
– Press <ENTER> to apply any changes.
– Press <ESC> to discard any changes.

Entering numbers and characters
The function keys are used to enter numbers and characters.
Proceed as follows:
1. Activate the operation of the operating element.
2. Press the respective key repeatedly until the character you want appears on the screen.
The assignment of the function keys to letters and numbers can be restricted based on
the format of the operating element.
The desired character is applied in about one second or immediately after pressing a
different button.
3. To navigate within the given character string, use the cursor keys.
4. Press <ENTER> to apply the entry.

Checking numerical value limits
Tags can be assigned limit values. Any entry of a value outside this limit is rejected. If an
alarm view is configured, a system alarm is triggered and the original value is displayed
again.
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Decimal places of numerical values
The configuration engineer can define the number of decimal places for a numerical text box.
The number of decimal places is checked when you enter a value in this type of I/O field.
● Decimal places that exceed the limit are ignored.
● Unused decimal places are padded with "0" entries.

4.3

Operating KP400 Basic

4.3.1

Overview

Alphanumeric assignment of keys
The following table shows the alphanumeric assignment of the data input keys.
Key

Alphanumeric assignment

1

.<space>_\@#?!':;()€§^~°{}"|1

2

ABCÄÀ2

3

DEFÈ3

4

GHI4

5

JKL5

6

MNOÖ6

7

PRQRS7 for upper case letters, pqrsß7 for lower case letters

8

TUVÜ8

9

WXYZ9

0

+-*/=0

.

.,

General functions
You initiate functions either with keys or keyboard shortcuts. With keyboard shortcuts, hold
the first key down. Then press the second key.
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The following table shows the functions that are available both in the Control Panel and in
the project:
Key or key
combination

Function
Switches between upper and lower case

Deletes the character left of cursor.
Moves to the next operating element in the TAB order.
Moves to the previous operating element in the TAB order.
Deletes the character right of cursor. The following characters are moved one
position to the left.
Inserts a space.
Cancels an action, e.g., cancel an input and close the dialog
Value entry: Restores the original value.
Window: Closes the window without applying a change.
Help: Closes the Help and returns to the previous view.
Executes a command, e.g.:
•

Operating buttons

•

Open dialog or select menu command

•

Check value, apply value after successful check and close the dialog

Operating elements: Activates the next operating element in the respective
direction
Input: Moves the cursor in the respective direction
List: Selects the next list entry.
Within a text box: Switches to the next or previous numerical or alphanumerical
character
Within a list: Selects the next list entry
Move the cursor or selection one screen up.
Move the cursor or selection one screen down.
Switches to another key mapping.
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Operating the Control Panel and dialogs
The following table shows additional key functions when operating the Control Panel and the
associated dialogs.
Key or key
combination

Function
On tab level: Switches between tabs
Within a text box: Positions the cursor
Activates tab level, text boxes, buttons or options from top to bottom or from
left to right
Activates tab level, text boxes, buttons or options from bottom to top or from
right to left
Selects or clears check boxes as well as the element of a radio button

Operating a project
The following table shows additional key functions when operating an ongoing project.
Key or key combination

Function
Acknowledges the currently displayed error alarm or all the alarms
of an alarm group as group acknowledgment.
Calls up the configured infotext for an operating element.

Operating function keys
The function keys can be assigned global or local functions:
● Function keys with global function assignment
A function key with global function assignment always triggers the same action on the
HMI device or in the PLC, regardless of the currently displayed screen. An example of
such an action is the activation of a screen, or the closing of an alarm window.
● Function keys with local function assignment
A function key with local function assignment is screen-specific and is therefore only
effective within the active screen.
The function assigned to a function key can vary from screen to screen.
The function key can be assigned only a single function, either global or local, within a
screen. Local function assignments override global function assignments.
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4.3.2

Entering data on the KP400 Basic
Data input on an HMI device is similar to operating the keys on a cell phone. Each key has
several functions. When you press a data input key for long enough, the number is
automatically inserted.
The following figure is an example for input of an alphanumeric value.

Requirement
The cursor must be in the text box.

Procedure
Proceed as follows:
1. Press the respective key repeatedly until the desired character is selected in the preview.
The allocation of keys may be restricted to letters or numbers, depending on the context.
The desired character is applied in about one second or immediately after pressing a
different button.
2. To toggle between upper and a lower case, press <a/A>.

All subsequent characters are written either in upper or lower case.
3. To navigate within the given character string, use the cursor keys.
4. If you enter values in the Control Panel, you can apply them with <ENTER> or <TAB>:
– <ENTER>: Closes the dialog.
– <TAB>: Navigates to the next operating element within the dialog.
5. If you enter values in the project, you can apply them with <ENTER>.
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5.1

Configuring devices with graphical Control Panel

5.1.1

Opening the Control Panel
With the exception of the KP300 Basic mono PN, all Basic Panels have a graphic Control
Panel.
Open the Control Panel by pressing
the "Control Panel" button of the
Loader.
Configure your HMI device in the
Control Panel. You can make the
following settings:



%DVLF3DQHOV'3

•

Communication settings

•

Settings for operation

•

Password protection

•

Transfer settings

•

Screen saver

• Acoustic signals
The "MPI / Profibus Settings" is only
available on Basic Panels DP.
The "Profinet" is only available on
Basic Panels PN.
The "Sound Settings" symbol is only
available on devices with sound
reproduction.
%DVLF3DQHOV31
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Protecting the Control Panel with a password
You can protect the Control Panel against unauthorized operation. You can read the settings
in the Control Panel without having entered a password, however, you are not allowed to edit
the settings.
This prevents inadvertent operations and increases security for the plant or machine
because the settings cannot be edited.
NOTICE
If the password is no longer available for the Control Panel, you first have to update the
operating system before you can make any changes in the Control Panel.
All data on the HMI device is overwritten when you update the operating system.

5.1.2

Overview
The following table shows the functions available in the Control Panel for configuring your
HMI device. Individual functions may be hidden, depending on the device type and device
configuration.
Symbol

Function
Changing MPI/DP settings (Page 69)

Changing the network configuration (Page 70)
Time server configuration (Page 71)
Changing monitor settings (Page 72)
Displaying information about the HMI device (Page 73)
Calibrating the touch screen (Page 74)
Displaying licensing information for the HMI device (Page 75)
Changing password settings (Page 78)

Enabling a data channel (Page 76)

Setting the Screen Saver (Page 79)

Setting acoustic signals (Page 79)
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5.1.3

Changing MPI/DP settings
Note
The settings for MPI or PROFIBUS DP communication are defined in the HMI device project.
Edit the transfer settings only in the following situations:
• Initial transfer of a project.
• Changes made to the project are activated at a later time.

1. Press "MPI / Profibus Settings" to
open the "MPI / Profibus Settings"
dialog.


2. Deactivate the "Panel is the only
master on the bus" check box if
additional masters are connected
to the bus.



A

A





3. Enter the bus address for the HMI
device in the "Address" text box.
The bus address must be unique
within the MPI/PROFIBUS DP
network.
Enter the time limit for PROFIBUS
communication in the "Time-out"
text box.
Valid values are 1 s, 10 s and
100 s.
4. Select the transmission rate from
the "Transmission Rate" text box.
Enter the highest station address
on the bus in the "Highest Station"
text box. Valid range of values: 1 to
126.
Select the profile from the "Profile"
selection box.

Press the "Bus Parameters..."
button to view the PROFIBUS
profile data.
5. Close the dialog and save your
entries with "OK".
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5.1.4

Changing the network configuration
NOTICE
Communication errors caused by IP address conflicts
Communication errors can occur if several devices in a network share the same IP
address.
Assign each HMI device an IP address that is unique within the network.
1. Press "Profinet" to open the
"Profinet Settings" dialog.
2. Choose either automatic address
assignment via DHCP, or user-specific
address assignment.



3. If assigning a user-specific address, use
the screen keyboard to enter valid
values in the "IP Address", "Subnet
Mask" text boxes and if applicable in the
"Default Gateway" text box.



4. Open the "Mode" tab.


A



5. Enter the transmission rate for the
PROFINET network in the "Speed" text
box. Valid values are 10 Mbps and
100 Mbps.
6. Select "Half duplex" or "Full duplex" as
the connection mode.
7. If the "Auto Negotiation" check box is
selected, the transmission type and
transmission rate in the PROFINET
network will be automatically detected
and set.



A

8. If the "Deactivate LLDP" check box is
selected, the HMI device exchanges no
information with other HMI devices.





9. Open the "Device" tab.
10. Enter a network name for your HMI
device. The name must meet the
following conditions.






A



–

Maximum length: 240 characters

–

Characters "a" to "z", numbers "0" to
"9"; allow special characters: "-" and
"."

–

Invalid syntax: "n.n.n.n" (n=0 to 999)
and "port-yxz" (x, y, z =0 to 9)

11. Close the dialog and save your entries
with "OK".
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5.1.5

Time server configuration
The HMI device has an unbuffered realtime clock. The realtime clock is set either using the
configuration or using a time server.
To fetch the time-of-day of the HMI device from a time server, specify up to four different
time servers. The time-of-day is synchronized via the "Network Time Protocol" (NTP). Also
specify the update cycle of the time-of-day and, if necessary, a time shift. Update cycle and
time shift are valid for all configured time servers.
You can test the availability of each time server separately.
1. Press "Profinet" to open the
"Profinet Settings" dialog.
2. Open the "NTP" tab.
3. At "Update Rate", enter the time
duration in seconds according to which
the time-of-day will be synchronized.



Value range: 10 to 86400 (1 day)
4. If required, use the "-" and "+" buttons to
set the time shift in "±hh:mm".




A

Value range: -24:00 to +24:00
5. Press "Configure" to open the
configuration of the time server.



6. Enter the IP address of the time server
at "IP Address".



7. Use the "Test" button to test the
availability of the time server.
The connection is established. If the
connection was successfully
established, date and time are
displayed. Any value set at "Time shift"
will not be taken into consideration.



8. Close the dialog and save your entries
with "OK".



9. Close the dialog and save your entries
with "OK".



A
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5.1.6

Changing monitor settings
NOTICE
Orientation of the screen for KTP400 Basic and KTP600 Basic
The screen orientation is defined by the configuration engineer in the course of project
creation. The appropriate screen orientation is set automatically when you transfer the
project to the HMI device.
Do not make any changes to the screen orientation if a project exists on the HMI device.
The screen content may otherwise be truncated.
1. Press "OP" to open the "OP Properties"
dialog.
2. Basic Panels Color
(except KTP600 Basic color):



Press the "UP" and "DOWN" buttons to adjust
the screen brightness.
Basic Panels mono:




Press the "UP" and "DOWN" buttons to adjust
the screen contrast.
3. KTP400 Basic and KTP600 Basic only:



KTP400 Basic
KTP600 Basic

A



Select the screen orientation:
–

"Landscape" for landscape

–

"Portrait" for portrait

4. Set the delay time in the "Delay time" text
box. The delay time in seconds defines the
waiting time expiring between the appearance
of the loader and the start of the project.
Valid range of values: 0 s to 60 s.
5. Close the dialog and save your entries with
"OK".

Note
Immediate start of the project with a delay time of 0 seconds
The project starts immediately if a delay time of 0 seconds is set. It is then no longer possible
to call the Loader after switching on the HMI device. To handle this situation, you need to
configure an operator control with the "Close project" function.
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5.1.7

Displaying information about the HMI device
1. Press "OP" to open the "OP Properties"
dialog.
2. Open the "Device" tab.



The "Device" tab is used to display specific
information on the HMI device. You will need
this information when contacting Technical
Support.
–

"Device:" HMI device name

–

"Flashsize": Size of internal flash memory
in which the HMI device image and project
data are saved. The size of internal flash
memory is not equivalent to application
memory available for a project.

–

"Bootloader": Boot loader version

–

"Bootl. Rel. Date": Release date of the
boot loader

–

"Image": Version of the HMI device image




3. Close the dialog with "OK."
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5.1.8

Calibrating the touch screen
This function is only available for touch screen devices.
1. Press "OP" to open the
"OP Properties" dialog.
2. Change to the "Touch" tab.



3. Press "Recalibrate" to open the
calibration screen.


4. Touch the cross in the screen center
using the touch pen or your finger.



5. Using the touch pen or your finger,
touch the floating cross in the
corners of the screen.
6. Touch the cross in the screen center
once again using the touch pen or
your finger to confirm your entries.



7. Close the dialog and save your
entries with "OK".



&DUHIXOO\SUHVVDQGEULHIO\KROGVW\OXVRQWKHFHQWHURI
WKHWDUJHW5HSHDWDVWKHWDUJHWPRYHVDURXQGWKHVFUHHQ



New calibration settings have been measured.
Tap the screen to register saved data.
Wait for 30 seconds to cancel saved data and
keep the current setting.



Time limit: 30 sec
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5.1.9

Displaying licensing information for the HMI device
1. Press "OP" to open the "OP Properties"
dialog.
2. Open the "License" tab.



The "License" tab is used to display the
licensing information for the software of the
HMI device.




3. Close the dialog with "OK."

Basic Panels
Operating Instructions, 04/2012, A5E02421799-03

75

Configuring the HMI device
5.1 Configuring devices with graphical Control Panel

5.1.10

Enabling a data channel
You must enable at least one data channel to transfer a project to the HMI device.
Note
After having completed the project transfer, you can protect the HMI device against
unintentional overwriting of project data and of the HMI device image by locking all data
channels.

Enabling a data channel - Basic Panels DP
1. Press "Transfer" to open the "Transfer
Settings" dialog.
2. If the HMI device is interconnected with the
configuring PC via PC-PPI cable, activate the
"Enable Channel" check box in the "Channel
1" field.











If the HMI device is interconnected with a
programming device via PROFIBUS, activate
the "Enable Channel" check box in the
"Channel 2" field.
Press the "Advanced" button to open the
"MPI / Profibus Settings" dialog. Verify the
PROFIBUS parameters in this dialog. A
description of the "MPI / Profibus Settings"
dialog is provided in chapter 5.1.3, Changing
MPI/DP settings (Page 69).
3. Close the dialog and save your entries with
"OK".

Note
Automatic transfer is activated be setting the "Remote Control" check box. If automatic
transfer is activated, the HMI device can be set remotely to transfer mode by a configuring
PC or programming device.
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Enabling a data channel - Basic Panels PN
1. Press "Transfer" to open the "Transfer
Settings" dialog.
2. Select the "Enable Channel" check box in the
"Channel 1" field.





Press the "Advanced" button to open the
"Profinet Settings" dialog. Verify the network
parameters in this dialog. A description of the
"Profinet Settings" dialog is provided in
chapter 5.1.4, Changing the network
configuration (Page 70).



3. Close the dialog and save your entries with
"OK".


Note
Automatic transfer is activated be setting the "Remote Control" check box. If automatic
transfer is activated, the HMI device can be set remotely to transfer mode by a configuring
PC or programming device.
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5.1.11

Changing password settings
Password protection prevents unauthorized access to the Control Panel.
NOTICE
The password cannot contain spaces or special characters * ? . % / \ ' ".
If the password is no longer available for the Control Panel, you first have to update the
operating system before you can make any changes in the Control Panel. All data on the
HMI device will be overwritten when you update the operating system.

Procedure – activating password protection
1. Press "Password" to open the "Password
Properties" dialog.
2. Enter a password in the "Password" text box.
Touch the text box. The alphanumerical
screen keyboard is displayed.



3. Confirm the password in the "Confirm
Password" text box.


A
A

4. Close the dialog and save your entries with
"OK".





Procedure – Deactivating password protection
1. Press "Password" to open the "Password
Properties" dialog.
2. Delete the entries in the "Password" text box.
3. Delete the entries in the "Confirm Password"
text box.



4. Close the dialog and save your entries with
"OK".


A
A
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5.1.12

Setting the Screen Saver
NOTICE
Burn-in effect
The screen contents may leave a faint version (ghost) of the image in the background if
they appear for too long.
The "ghost" will disappear automatically after some time. The longer the same content is
displayed on the screen, the longer it will take for the burn-in effect to disappear.
The screen saver helps to prevent burn-in.
Always use the screen saver.
1. Press "Screensaver" to open the
"Screensaver Settings" dialog.
2. Enter the number of minutes before the
screen saver is to be activated.
Touch the text box to do this. You can enter
values from 5 to 360 minutes. Entering "0"
disables the screen saver.



3. Close the dialog and save your entries with
"OK".


A

5.1.13



Setting acoustic signals
This function is only available for touch screen devices.
1. Press "Sound Setting" to open the "Sound
Settings" dialog.
2. Select the "Sound ON" check box. If the
"Sound ON" check box is selected, you get
acoustic feedback when you touch the
touch screen.



3. Close the dialog and save your entries with
"OK".
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5.2

Configuring KP300 Basic

5.2.1

Opening the Control Panel
Use the "Info/Settings" menu command to open the Control Panel in the Loader.
Configure your HMI device in the Control Panel. You can make the following settings:
● Communication settings
● Settings for operation
● Password protection
● Transfer settings
● Screen saver

Protecting the Control Panel with a password
In the control panel you have the option of protecting the "Info Settings > Logon/Settings"
menu with a password. The following menu entries continue to be freely accessible even
when password protection is enabled:
● Transfer
● Start
● Info Settings > Contrast
● Info Settings > Device / Network / Version / License Info
This prevents inadvertent operations and increases security for the plant or machine
because the settings cannot be edited.
NOTICE
If the password for the Control Panel is no longer available, you have to first update the
operating system before you can make any changes in the Control Panel at "Info Settings >
Logon/Settings".
All data on the HMI device is overwritten when you update the operating system!
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5.2.2

Overview
The following table shows the menu structure of the Control Panel with the functions that are
available there for configuring your HMI device.
Menu entry

Function / Note

Start
Transfer
Info/Settings
Contrast

Changing monitor settings (Page 83)

[...] Info

Displaying information about the HMI device
(Page 83)

Logon/Settings
Startup Delay

Setting the Screen Saver (Page 88)

Value
Screensaver

Changing monitor settings (Page 83)

Value
Password

Changing password settings (Page 87)

Password
Confirm Password
Transfer/Network
Channel 1: PROFINET

Enabling a data channel (Page 84)

Enable (rem. on)
Enable (rem. on)
Disabled
IP Address/Station Name

Changing the network configuration (Page 85)

Station Name
Station Name
IP Address static or via
DHCP
IP via DHCP
static IP
IP Address

Only available if "static IP" is set.

Value
Subnet Mask

Only available if "static IP" is set.

Value
Def. Gateway

Only available if "static IP" is set.

Value
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Network Mode

Changing the network configuration (Page 85)

LLDP Protocol
Enable
Disable
Auto Negotiation
Enable
Disable
Speed

Only available if "Auto Negotiation = Enable"

10 Mbits/s
100 Mbits/s
Communication Link

Only available if "Auto Negotiation = Enable"

Half-Duplex
Full-Duplex
NTP

Time server configuration (Page 86)

Synchronisation with
time server
Enable
Disable
Server [1..4] IP Address Only available if "Synchronisation with time server
= Disable"
Value
Test Server [1..4]
DateTime
Update rate

Only available if "Synchronisation with time server
= Disable"
Shows date and time of the time server after a
connection has been successfully established.
Duration in seconds according to which the time-ofday is synchronized.

Value
Time shift

Time difference in "hh:mm"

Value
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5.2.3

Displaying information about the HMI device

Menu commands in the "Info/Settings" menu
The following table shows the menu commands in the "Info/Settings" menu:
Menu item

Information contained there

Device Info

HMI device name
Size of the internal flash memory in which the HMI device image and project
are stored The size of internal flash memory is not equivalent to application
memory available for a project.

Network Info

IP address, MAC address and name of the HMI device.
If the name does not fit in a row, the name is abbreviated and marked with
"...".

Version Info

Version of the HMI device image
Version and release date of the Boot loader

License Info

License provisions

Procedure
Proceed as follows:
1. Switch to "Info/Settings" menu on the HMI device.
2. Select the desired menu command.
3. Press <ESC> or <ENTER> to go back to the higher-level menu.

5.2.4

Changing monitor settings

Procedure
Proceed as follows:
1. To change the contrast:
– Switch to "Info/Settings > Contrast" menu on the HMI device.
– User the cursor keys <Up> and <Down> to change the contrast and confirm with
<ENTER>.
2. To enter the display time duration of the Loader prior to project start:
– Switch to "Info/Settings > Logon/Settings > Startup Delay" menu on the HMI device.
– Activate the list with <ENTER> and enter the display time duration in seconds.
Value range: 0 to 60
– Confirm with <ENTER>.
Note
Immediate start of the project with a delay time of 0 seconds
The project starts without delay if a delay time of 0 seconds is set. It is then no longer
possible to call the Loader after switching on the HMI device. To handle this situation,
you need to configure an operating element with the "Close project" function.
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5.2.5

Enabling a data channel
You must enable at least one data channel to transfer a project to the HMI device.
Note
After having completed the project transfer, you can protect the HMI device against
unintentional overwriting of project data and of the HMI device image by locking all data
channels.

Procedure
Proceed as follows:
1. Switch to "Info/Settings > Logon/Settings > Transfer / Network" menu on the HMI device.
2. Using the <<Up> and <Down> cursor keys, select the desired mode under "Channel 1:
PROFINET".
– "Enable (rem.on)": Activates the data channel and also the automatic transfer
– "Enable (rem.off)": Activates the data channel without automatic transfer
– "Disable": Deactivates the data channel
3. Confirm the selection with <ENTER>.
Note
If automatic transfer is activated, the HMI device can be set remotely to transfer mode by
a configuring PC or programming device.
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5.2.6

Changing the network configuration
NOTICE
Communication errors caused by IP address conflicts
Communication errors can occur if several devices in a network share the same IP
address.
Assign each HMI device an IP address that is unique within the network.

Procedure
Proceed as follows:
1. Switch to "Info/Settings > Logon/Settings > Transfer/Network > IP Address/Station Name"
menu on the HMI device.
2. To enter a name for the HMI device, enter a name under "Station Name".
Rules for names:
– Not more than 240 characters
– Characters "a" to "z", numbers "0" to "9"; allow special characters: "-" and "."
– Invalid syntax: "n.n.n.n" (n=0 to 999) and "port-yxz" (x, y, z =0 to 9)
3. Select either automatic address assignment via DHCP or manual address assignment:
– To acquired the IP address from a DHCP server, set the value under "IP address
static or via DHCP" to "IP via DHCP"
– To set a fixed IP address, set the value under "IP address static or via DHCP" to
"static IP".
The entries "IP Address", "Subnet Mask" and "Def. Gateway are also displayed in the
"IP Address/Station Name" menu.
4. If you have assigned a static IP address, enter valid values under "IP Address", "Subnet
Mask" and, if required, under "Def. Gateway".
5. Switch to "Info/Settings > Logon/Settings > Transfer/Network > Network Mode" menu on
the HMI device.
6. If necessary, set the value under "LLDP Protocol" to "Enable".
7. Configure the settings for connection type and transmission rate:
– To assign the connection type and transmission rate automatically, set the value
under "Auto Negotiation" to "Enable"".
– To assign the connection type and transmission rate manually, set the value under
"Auto Negotiation" to "Disable"".
The entries "Speed" and "Communication Link" are also displayed in the "Network
Mode" menu.
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8. If you assign the connection type and transmission rate manually, select the desired
values under "Speed" and "Communication Link".
– Select "100 Mbps" or "10 Mbps".
– Select "Half-Duplex" or "Full-Duplex".

5.2.7

Time server configuration

Introduction
The HMI device has an unbuffered realtime clock. The realtime clock is set either using the
configuration or using a time server.
To fetch the time-of-day of the HMI device from a time server, specify up to four different
time servers. The time-of-day is synchronized via the "Network Time Protocol" (NTP). Also
specify the update cycle of the time-of-day and, if necessary, a time shift. Update cycle and
time shift are valid for all configured time servers.
You can test the availability of each time server separately.

Procedure
Proceed as follows:
1. Switch to "Info/Settings > Logon/Settings > Transfer/Network > NTP" menu on the HMI
device.
2. To activate the acquisition of a time-of-day from a time server, set the value under
"Synchronisation with time server" to "Enable".
The menu entries "Server <Number> IP Address ", Test Server <Number>", "Update
rate" and "Time shift" appear.
3. Enter the IP address of the time server under "Server <Number> IP Address ".
4. To test the availability of the time server, select the command "Test Server <Number>".
The connection is established. If the connection was successfully established, date and
time are displayed. Any value set at "Time shift" will not be taken into consideration.
5. If required, configure additional time servers.
6. At "Update rate", enter the time duration in seconds according to which the time-of-day
will be synchronized.
Value range: 10 to 86400 (1 day)
7. If required, enter the time shift in "±hh:mm" under "Time shift".
Value range: -24:00 to +24:00
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5.2.8

Changing password settings
Password protection prevents unauthorized access to the "Info/Settings > Logon/Settings"
menu.
NOTICE
The password cannot contain spaces or special characters * ? . % / \ ' ".
If the password for the "Info/Settings > Logon/Settings" menu is no longer available, you
have to first update the operating system before you can make any changes in the
"Info/Settings > Logon/Settings" menu. All data on the HMI device will be overwritten when
you update the operating system.

Activating password protection
Proceed as follows:
1. Switch to "Info/Settings > Logon/Settings > Password" menu on the HMI device.
2. Enter the password under "Password".
3. Confirm the password under "Confirm Password".
4. Exit the menu with <ENTER>.

Deactivating password protection
Proceed as follows:
1. Switch to "Info/Settings > Logon/Settings > Password" menu on the HMI device.
2. Delete the password under "Password".
3. Confirm the (empty) password under "Confirm Password".
4. Exit the menu with <ENTER>.
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5.2.9

Setting the Screen Saver
NOTICE
Burn-in effect
The screen contents may leave a faint version (ghost) of the image in the background if
they appear for too long.
The "ghost" will disappear automatically after some time. The longer the same content is
displayed on the screen, the longer it will take for the burn-in effect to disappear.
The screen saver helps to prevent burn-in.
Always use the screen saver.

Procedure
Proceed as follows:
1. Switch to "Info/Settings > Logon/Settings > Screensaver" menu on the HMI device.
2. Enter the number of minutes before the screen saver is to be activated under "Value".
Value range: 5 to 360; "0" deactivates the screen saver.
3. Confirm the entry with <ENTER>.
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6

Overview

Configuration phase
A project – the process image of the working process – is created during configuration to
visualize automated working processes. The process displays for the project contain
displays for values and messages which provide information about process statuses. The
process control phase follows the configuration phase.

Process control phase
The project must be transferred to the HMI device if it is to be used in process control.
Another precondition for process control is that the HMI device is connected online to a PLC.
Current working processes - operating and observing - can then be subject to process
control.

Transferring the project to the HMI device
You can transfer a project to an HMI device as follows:
● Transfer from the configuring PC
● Restore from a PC using ProSave
In this case, an archived project is transferred from a PC to the HMI device. The
configuration software need not be installed on this PC.
ProSave is a service tool that enables you to manage data on your HMI device. With
ProSave, you can, for example, update the operating systems of the HMI device or
backup its data.

Commissioning and recommissioning
Initial and re-start-ups differ in the following respects:
● When the HMI device is commissioned there is no project at first.
The HMI device is also in this state after the operating system has been updated.
● When recommissioning, any project already on the HMI device is replaced.
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6.2

Operating modes

Operating modes
The HMI device may be in the following operating modes:
● Offline
● Online
● Transfer
"Offline mode" and "Online mode" can be set on both the configuring PC and the HMI
device. To set these modes on the HMI device, use a corresponding operating element of
the project.

Changing the operating mode
The configuration engineer must have configured an appropriate operating element to allow
a change of the operating mode on the HMI device during ongoing operation.
Further information on this may be available in your plant documentation

"Offline" operating mode
In this mode, there is no communication between the HMI device and PLC. Although the
HMI device can be operated, it cannot exchange data with the PLC.

"Online" operating mode
In this mode, the HMI device and PLC communicate. You can operate the plant on the HMI
device according to your system configuration.

"Transfer" mode
In this mode, you can transfer a project from the configuring PC to the HMI device or backup
and restore HMI device data, for example.
The following options are available for setting "Transfer" mode on the HMI device:
● When the HMI device starts up
Start "Transfer" mode manually in the HMI device Loader.
● During ongoing operation
Start the "Transfer" mode manually within the project using an operating element. The
HMI device toggles to "Transfer" mode when automatic mode is set and a transfer is
initiated on the configuring PC.
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6.3

Data transmission options

Overview
The following table shows the options for data transfer between the HMI device and
configuration PC.

1

Type

Data channel

Backup/restore,

Serial

Operating system update

MPI/PROFIBUS DP

Project transfers

PROFINET

Updating the operating system
with "Reset to factory settings"

Serial

1

Basic Panels DP

Basic Panels PN

Yes

-

Yes

-

-

Yes

Yes

-

MPI/PROFIBUS DP

-

-

PROFINET

-

Yes

1

Applies for operations with PC/PPI cable 6ES7 901-3CB30-0XA0 or USB/PPI cable
6ES7 901-3DB30-0XA0.

6.4

Transfer

6.4.1

Overview
Transfer the executable project from the configuration PC to the HMI device.
You can start the "Transfer" mode manually or automatically on the HMI device.
Transferred data is written directly to internal flash memory of the HMI device. Parameterize
a corresponding data channel before you start the transfer.

6.4.2

Starting manual transfer

Introduction
You can manually switch the HMI device to "Transfer" mode as follows:
● At runtime, using a configured operating element.
● In the Loader of the HMI device.

Requirements
● The project is open in WinCC flexible or WinCC.
● The project is compiled.
● The HMI device is connected to a configuring PC.
● The data channel is configured on the HMI device.
● The HMI device is in "Transfer" mode.
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Procedure (WinCC flexible)
Proceed as follows:
1. On the configuring PC, select the "Transfer settings" command from the "Project >
Transfer" menu in WinCC flexible.
The "Select devices for transfer" dialog opens.
2. Select the HMI device in the left area of the dialog.
3. Select the type of interconnection for the HMI device and the configuring PC.
Set the connection parameters.
4. Set the transfer parameters in the right area of the dialog.
5. Start the transfer in WinCC flexible by selecting "Transfer".
The configuring PC checks the connection to the HMI device. The project is transferred to
the HMI device. An error message is displayed on the configuring PC if the connection is
not available or disrupted.

Procedure (WinCC)
If you are loading a project on an HMI device, the "Advanced loading" dialog is automatically
opened. You configure the appropriate interface parameters in this dialog.
For further information, refer to the documentation on WinCC.
Proceed as follows:
1. If you want to load a project simultaneously on several HMI devices, use multiple
selection to select all the desired HMI devices in the project tree.
2. Select the "Load to device > Software" command in the shortcut menu of an HMI device.
3. When the "Advanced loading" dialog appears, configure the "Settings for loading":
– Select the interface via which the project will be loaded.
– Configure the corresponding interface parameters.
– Click on "Load".
You can open the "Advanced loading" dialog at any time via the menu command
"Online > Advanced loading to device…"
The "Load preview" dialog" opens. The entire project is compiled at the same time. The
results is displayed in the "Load preview" dialog.
4. Check the displayed default settings, and edit these if necessary.
5. Click on "Load".

Result
The project is available on the HMI device following successful transfer. The transferred
project is started automatically.
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6.4.3

Starting automatic transfer

Introduction
If automatic transfer is activated, the HMI device automatically changes to "Transfer" mode
at runtime as soon as a transfer is started on the connected configuring PC.
Note
With automatic transfer, the HMI device only changes into "Transfer" mode when the project
is running on the HMI device.
Automatic transfer is particularly suited for the test phase of a new project since transfer is
completed without interfering with the HMI device.
NOTICE
If automatic transfer is activated on the HMI device and a transfer is initiated on the
configuring PC, the project currently running is automatically stopped. The HMI device then
automatically switches to "Transfer" mode.
After the commissioning phase, deactivate the automatic transfer so that the HMI device
cannot be inadvertently switched to transfer mode. Transfer mode can trigger unintentional
actions in the plant.
You can issue a password in the Control Panel to restrict access to the transfer settings
and thus avoid unauthorized modifications.

Requirements
● The project is open in WinCC flexible or WinCC.
● The project is compiled.
● The HMI device is connected to a configuring PC.
● The data channel is configured on the HMI device
● The HMI device is in "Transfer" mode.
● The automatic transfer is activated in the data channel for the transfer
● The project is started on the HMI device.
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Procedure (WinCC flexible)
Proceed as follows:
1. On the configuring PC, select the "Transfer settings" command from the "Project >
Transfer" menu in WinCC flexible.
The "Select devices for transfer" dialog opens.
2. Select the HMI device in the left area of the dialog.
3. Select the type of interconnection for the HMI device and the configuring PC.
Set the connection parameters.
4. Set the transfer parameters in the right area of the dialog.
5. Start the transfer in WinCC flexible by selecting "Transfer".

Procedure (WinCC)
If you are loading a project on an HMI device, the "Advanced loading" dialog is automatically
opened. You configure the appropriate interface parameters in this dialog.
For further information, refer to the documentation on WinCC.
Proceed as follows:
1. If you want to load a project simultaneously on several HMI devices, use multiple
selection to select all the desired HMI devices in the project tree.
2. Select the "Load to device > Software" command in the shortcut menu of an HMI device.
3. When the "Advanced loading" dialog appears, configure the "Settings for loading":
– Select the interface via which the project will be loaded.
– Configure the corresponding interface parameters.
– Click on "Load".
You can open the "Advanced loading" dialog at any time via the menu command
"Online > Advanced loading to device…"
The "Load preview" dialog" opens. The entire project is compiled at the same time. The
results is displayed in the "Load preview" dialog.
4. Check the displayed default settings, and edit these if necessary.
5. Click on "Load".

Result
The configuring PC checks the connection to the HMI device. The HMI device shuts down
the current project and automatically changes to "Transfer" mode. The project is transferred
to the HMI device. An error message is displayed on the configuring PC if the connection is
not available or disrupted.
The project is available on the HMI device following successful transfer. The transferred
project is started automatically.
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6.4.4

Testing a project

Introduction
You have the following options to test a project:
● Test the project on the configuring PC
You can test a project at a configuring PC, using a simulator. For detailed information,
refer to the "WinCC flexible" user manual and to the WinCC flexible and WinCC Online
Help.
● Offline testing of the project on the HMI device
Offline testing means that communication between the HMI device and PLC is down
while the test is being carried out.
● Online testing of the project on the HMI device
Online testing means that the HMI device and PLC communicate with each other during
testing.
Perform the tests, starting with the "Offline test", followed by the "Online test".
Note
You should always test the project on the HMI device on which the project will be used.
Check the following:
1. Check the correct layout of the screens.
2. Check the screen navigation.
3. Check the input objects.
4. Enter the tag values.
The test ensures that the project will run as you intended on the HMI device.

Requirements for offline testing
● The project has been transferred to the HMI device.
● The HMI device is in "Offline" mode.

Procedure
In "Offline" mode, you can test individual project functions on the HMI device without them
being affected by the PLC. PLC tags, therefore, are not updated.
Test the operator controls and visualization of the project as far as possible without
connecting to the PLC.
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Requirements for online testing
● The project has been transferred to the HMI device.
● The HMI device is in "Online" mode.

Procedure
In "Online" mode, you can test individual project functions on the HMI device without them
being affected by the PLC. PLC tags are updated in this case.
You have the option to test all communication-dependent functions, for example alarms, etc.
Test the operator controls and views of the project.

6.5

Backup and restore

6.5.1

Overview

Backup and restore
You can back up and restore the following data in the internal flash memory of the HMI
device with a PC:
● Project and HMI device image
● Password list
● Recipe data
Use one of the following tools for backup and restore:
● WinCC
● WinCC flexible
● ProSave

General information
NOTICE
Power failure
If a complete restore operation is interrupted due to power failure on the HMI device, the
operating system of the HMI device may be deleted. In this case, you have to reset the HMI
device to its factory settings.
Compatibility conflict
If a message is output on the HMI device warning of a compatibility conflict during the
restore operation, the operating system must be updated.
Note
A data transfer can take several minutes, depending on data volume and transmission rate.
Observe the status display. Do not interrupt the data transfer.
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See also
Data transmission options (Page 91)

6.5.2

Backup and restore using WinCC flexible

Requirement
● No project is open on the configuration PC in WinCC flexible.
● The HMI device is connected to this configuration PC.
● The data channel is programmed on the HMI device.

Procedure – backup
Proceed as follows:
1. On the configuration PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.
The "Communication settings" dialog box opens.
2. Select the type of HMI device.
3. Select the type of connection between the HMI device and the configuration PC.
Set the connection parameters.
4. Close the dialog with "OK".
5. Select the "Backup" command in the menu "Project > Transfer" in WinCC flexible.
The "Backup settings" dialog opens.
6. Select the data to be backed up.
7. Select a destination folder and a file name for the "*.psb" backup file.
8. Set "Transfer" mode on the HMI device.
If automatic transfer mode is enabled on the HMI device, the HMI device automatically
sets "Transfer" mode when a backup is initiated.
9. Start the backup operation in WinCC flexible with "OK" on the configuration PC.
10.Follow the instructions in WinCC flexible.
A status view opens to indicate the progress of the operation.

Result
The system outputs a message when the backup is completed.
The relevant data is now backed up on the configuration PC.
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Procedure – restoring
Proceed as follows:
1. On the configuration PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.
The "Communication settings" dialog box opens.
2. Select the type of HMI device.
3. Select the type of connection between the HMI device and the configuration PC.
4. Set the connection parameters.
5. Close the dialog with "OK".
6. Select the "Restore" command in the menu "Project > Transfer" in WinCC flexible.
The "Restore Settings" dialog opens.
7. Select the "*.psb" backup file to be restored from the "Open" field.
You can see the HMI device for which the backup file was created and the type of backup
data the file contains.
8. Set "Transfer" mode on the HMI device.
If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when a restore operation is initiated.
9. Start the restore operation in WinCC flexible with "OK" on the configuration PC.
Follow the instructions in WinCC flexible.
A status view opens to indicate the progress of the operation.

Result
When the restore is successfully completed, the data backed up on the configuration PC is
now on the HMI device.
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6.5.3

Backup and restore using ProSave

Requirements
● The HMI device is connected to a PC on which ProSave is installed.
● The data channel is parameterized on the HMI device.

Procedure – backup
Proceed as follows:
1. Go to the Windows Start menu and start ProSave on the PC.
2. Select the HMI device type in the "General" tab.
3. Select the type of interconnection for the HMI device and the PC.
Set the connection parameters.
4. Select the data to be backed up in the "Backup" tab.
– "Complete backup" generates a backup copy of configuration data, recipe data and
the HMI device image to a file in PSB format.
– "Recipes" generates a backup copy of the HMI device's recipe data records in PSB
format.
– "Recipes (CSV format)" saves a backup copy of the HMI device's recipe data records
to a text file in CSV format. The semicolon is used as column separator.
– "User management" generates a backup copy of the HMI device's user data in PSB
format.
5. Select the folder and file name for the *.psb" backup file .
When generating a backup copy of recipes in CSV format, only select a folder. A CSV file
is generated for each recipe in this folder.
6. Set "Transfer" mode on the HMI device.
If automatic transfer mode is enabled on the HMI device, the HMI device automatically
sets "Transfer" mode when a backup is initiated.
7. Start the backup operation in ProSave with "Start Backup".
Follow the instructions in ProSave.
A progress bar opens to indicate the progress of the operation.

Result
The system outputs a message when the backup is completed.
A backup copy of the data is now available on the PC.
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Procedure – restore
Proceed as follows:
1. Go to the Windows Start menu and start ProSave on the PC.
2. Select the HMI device type in the "General" tab.
3. Select the type of interconnection for the HMI device and the PC.
4. Set the connection parameters.
5. Select the "*.psb" backup file to be restored from the "Restore" tab.
You can see the HMI device for which the backup file was created and the type of backup
data the file contains.
Select one or several CSV files from the source folder to restore the recipes from CSV
files.
6. Set "Transfer" mode on the HMI device.
If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when a restore operation is initiated.
7. Start the restore operation in ProSave on the PC with "Start Restore".
8. Follow the instructions in ProSave.
A progress bar indicates the progress of the operation.

Result
When the restore is successfully completed, the data backed up on the PC is now on the
HMI device.

6.5.4

Backup and restore using WinCC

Requirements
● The HMI device is connected to the configuring PC or the PC with ProSave
● The HMI device is selected in the project navigation.
● If a server is used for data backup: The HMI device has access to the server

Backup of the data of the HMI device
Proceed as follows:
1. Select the "Backup" command from the "Online > HMI device maintenance" menu.
The "SIMATIC ProSave" dialog box opens.
2. Select the data to backup for the HMI device under "Data type".
3. Enter the name of the backup file under "Save as".
4. Click "Start Backup".
This starts the data backup. The backup operation takes some time, depending on the
connection selected.
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Restoring the data of the HMI device
Proceed as follows:
1. Select the "Restore" command from the "Online > HMI device maintenance" menu.
2. Enter the name of the backup file under "Save as".
Information about the selected backup file is displayed under "Content".
3. Click "Start Restore".
This starts the restoration. This operation takes some time, depending on the connection
selected.

6.6

OS update - Basic Panel DP

6.6.1

Overview

Updating the operating system
A compatibility conflict may occur when transferring a project to the HMI device. This is
caused by different versions of the configuration software used and the HMI device image
available on the HMI device. If there are different versions, the transfer is aborted. A
message indicating a compatibility conflict is displayed on the configuring PC.
There are two ways to match the versions:
● Update the HMI device image if the project was created with the most recent version of
the configuration software.
● Transfer a matching version of the HMI device image if you do not want to adapt the
project for the HMI device to the most recent version of the configuration software for the
project.
NOTICE
Data loss
All data on the HMI device, such as the project and licenses, will be deleted when you
update the operating system.
Note
Calibrating the touch screen
After the update, you may have to recalibrate the touch screen.
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6.6.2

Resetting factory settings
In ProSave, WinCC flexible or WinCC, you can update the operating system with or without
resetting to factory settings.
● Updating the operating system without reset to factory settings
First, switch into "Transfer" mode on the HMI device or use the automatic transfer
function if the project is active. Then start the operating system update in ProSave,
WinCC flexible or WinCC.
● Updating the operating system with reset to factory setting
NOTICE
Data channel
When resetting to factory settings, all data channel parameters used are reset. The
transfer can only be started following reconfiguration of the data channel.
Note
You have to perform an operating system update with reset to factory setting if the HMI
device does not yet have an operating system or if the HMI device's operating system is
corrupt.
First, start the operating system update in ProSave, WinCC flexible or WinCC, and switch
the power on the HMI device off and on again when prompted.

See also
Data transmission options (Page 91)

6.6.3

Updating the Operating System using WinCC flexible
CAUTION
Updating the operating system deletes all data on the HMI device
When you update the operating system you delete data on the target system. For this
reason, it is advisable to backup the following data:
• User administration
• Recipes
Resetting to factory settings also deletes the License Keys. You should also back up the
License Keys before resetting to factory settings.

Basic Panels

102

Operating Instructions, 04/2012, A5E02421799-03

Commissioning a project
6.6 OS update - Basic Panel DP

Requirements
● The HMI device is connected to a configuring PC.
● No project is open in WinCC flexible.
● When updating the operating system without reset to factory setting only:
The data channel is configured on the HMI device.

Procedure
Proceed as follows:
1. When updating the operating system with reset to factory setting only:
Switch off power to the HMI device.
2. On the configuring PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.
The "Communication Settings" dialog opens.
3. Select the type of HMI device.
4. Select the type of connection between the HMI device and the configuring PC, then set
the connection parameters.
5. Close the dialog box with "OK".
6. Select the "OS Update" command from the "Project > Transfer" menu in WinCC flexible.
7. Select whether to update the operating system with or without restoring the factory
settings by setting the "Reset to factory settings" check box accordingly.
8. Select the HMI device image file "*.img" under "Image path".
The HMI device image files are available under "WinCC flexible Images" in the
WinCC flexible installation folder or on the WinCC flexible installation DVD.
The output area provides information on the version of the successfully opened HMI
device image file.
9. When updating without reset to the factory settings only:
Set "Transfer" mode on the HMI device.
If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when an update is initiated.
10.In WinCC flexible, select "Update OS" on the configuring PC to run the operating system
update.
11.When updating with reset to the factory settings only:
Switch on the power supply to the HMI device.
12.Follow the instructions in WinCC flexible.
A progress bar indicates the progress of the operating system update.

Result
A message is displayed when the operating system update is successfully completed.
The HMI device no longer contains any project data.
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6.6.4

Updating the Operating System using ProSave

Requirements
● The HMI device is connected to a PC on which ProSave is installed.
● When updating the operating system without reset to factory settings only:
The data channel is configured on the HMI device.

Procedure
Proceed as follows:
1. When updating the operating system with reset to factory settings only:
Switch off power to the HMI device.
2. Go to the Windows Start menu and start ProSave on the PC.
3. Select the HMI device type in the "General" tab.
4. Select the type of connection between the HMI device and the PC, then set the
connection parameters.
5. Select the "OS Update" tab.
6. Select whether to update the operating system with or without restoring the factory
settings by setting the "Reset to factory settings" check box accordingly.
7. Select the HMI device image file "*.img" under "Image path".
WinCC flexible: The HMI device image files are available under "WinCC flexible Images"
in the WinCC flexible installation folder or on the installation CD.
WinCC: The HMI device image files are available under "Programme\Automation\Portal
V11\Data\Hmi\Transfer\11.0\Images".
The output area provides information on the version of the successfully opened HMI
device image file.
8. When updating without reset to the factory settings only:
Set "Transfer" mode on the HMI device.
If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when an update is initiated.
9. Select "Update OS" on the PC to run the operating system update.
10.When updating with reset to the factory settings only:
Switch on the power supply to the HMI device.
11.Follow the instructions in ProSave.
A progress bar indicates the progress of the operating system update.

Result
A message is displayed when the operating system update is successfully completed.
The HMI device no longer contains any project data.
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6.7

OS update - Basic Panel PN

6.7.1

Overview

Updating the operating system
A compatibility conflict may occur when transferring a project to the HMI device. This is
caused by different versions of the configuration software used and the HMI device image
available on the HMI device. If there are different versions, the transfer is aborted. A
message indicating a compatibility conflict is displayed on the configuring PC.
There are two ways to match the versions:
● Update the HMI device image if the project was created with the most recent version of
the configuration software.
● Transfer a matching version of the HMI device image if you do not want to adapt the
project for the HMI device to the most recent version of the configuration software for the
project.
NOTICE
Data loss
All data on the HMI device, such as the project and licenses, will be deleted when you
update the operating system.
Note
Calibrating the touch screen
After the update, you may have to recalibrate the touch screen.
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6.7.2

Resetting factory settings
In ProSave, WinCC flexible or WinCC, you can update the operating system with or without
resetting to factory settings.
● Updating the operating system without reset to factory settings
First, switch into "Transfer" mode on the HMI device or use the automatic transfer
function if the project is active. Then start the operating system update in ProSave,
WinCC flexible or WinCC.
● Updating the operating system with reset to factory setting
NOTICE
Data channel
When resetting to factory settings, all data channel parameters used are reset. The
transfer can only be started following reconfiguration of the data channel.
Note
You have to perform an operating system update with reset to factory setting if the HMI
device does not yet have an operating system or if the HMI device's operating system is
corrupt.
First, start the operating system update in ProSave, WinCC flexible or WinCC, and switch
the power on the HMI device off and on again when prompted.

See also
Data transmission options (Page 91)

6.7.3

Updating the operating system using WinCC flexible
If possible, you should use the interface with the highest bandwidth for this connection, such
as Ethernet. Updating the operating system via a serial connection can take up to an hour.
CAUTION
Updating the operating system deletes all data on the HMI device
When you update the operating system you delete data on the target system. For this
reason, it is advisable to backup the following data:
• User administration
• Recipes
Resetting to factory settings also deletes the License Keys. You should also back up the
License Keys before resetting to factory settings.
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Requirements
● No project is open on the configuring PC in WinCC flexible.
● The HMI device is connected to this configuring PC.
● The data channel is configured on the HMI device.

Procedure
Proceed as follows:
1. On the configuring PC, select the "Communication settings" command from the "Projekt >
Transfer" menu in WinCC flexible.
The "Communication Settings" dialog opens.
2. Select the type of HMI device.
3. Select the type of interconnection for the HMI device and the configuring PC.
4. Set the connection parameters.
5. Close the dialog box with "OK".
6. In WinCC flexible, select the command "OS Update" from the "Projekt > Transfer" menu.
7. Select the HMI device image file "*.img" under "Image path".
The HMI device image files are available under "WinCC flexible Images" in the
WinCC flexible installation folder or on the WinCC flexible installation CD.
The output area provides information on the version of the successfully opened HMI
device image file.
8. Switch into "Transfer" mode on the HMI device.
If you have activated automatic transfer mode for the HMI device, the device
automatically switches to "Transfer" mode when an update is initiated.
9. In WinCC flexible, select "Update OS" on the configuring PC to run the operating system
update.
10.Follow the instructions in WinCC flexible.
A progress bar indicates the progress of the operating system update.

Result
A message is displayed when the operating system update is successfully completed.
The HMI device no longer contains any project data.
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6.7.4

Updating the operating system using ProSave

Requirements
● The HMI device is connected to a PC on which ProSave is installed.
● The data channel is configured on the HMI device.

Procedure
Proceed as follows:
1. Go to the Windows Start menu and start ProSave on the PC.
2. Select the HMI device type in the "General" tab.
3. Select the type of connection between the HMI device and the PC.
4. Set the connection parameters.
5. Select the "OS Update" tab.
6. Select the HMI device image file "*.img" under "Image path".
WinCC flexible: The HMI device image files are available under "WinCC flexible Images"
in the WinCC flexible installation folder or on the installation CD.
WinCC: The HMI device image files are available under "Programme\Automation\Portal
V11\Data\Hmi\Transfer\11.0\Images".
The output area provides information on the version of the successfully opened HMI
device image file.
7. Switch into "Transfer" mode on the HMI device.
If you have activated automatic transfer mode for the HMI device, the device
automatically switches to "Transfer" mode when an update is initiated.
8. Select "Update OS" n the PC to run the operating system update.
9. Follow the instructions in ProSave.
A progress bar indicates the progress of the operating system update.

Result
A message is displayed when the operating system update is successfully completed.
The HMI device no longer contains any project data.
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6.7.5

Updating the operating system using WinCC
If possible, you should use the interface with the highest bandwidth for this connection, such
as Ethernet. Updating the operating system via a serial connection can take up to an hour.
CAUTION
Updating the operating system deletes all data on the HMI device
When you update the operating system you delete data on the target system. For this
reason, it is advisable to backup the following data:
• User administration
• Recipes
Resetting to factory settings also deletes the License Keys. You should also back up the
License Keys before resetting to factory settings.

Requirement
● The HMI device is connected to the configuring PC
● The appropriate data channel is configured on the HMI device.
● The HMI device is selected in the project navigation.

Procedure
Proceed as follows:
Proceed as follows to update the operating system:
1. Select the "Update operating system" command from the menu under "Online > HMI
device maintenance" on the configuring PC in WinCC.
The "SIMATIC ProSave [OS-Update]" dialog opens. The path to the image of the
operating system has been preset.
2. If necessary, select another path to the operating system image you want to transfer to
the HMI device.
3. Click "Update OS".

Result
This starts the update. The update operation can take time, depending on the connection
selected.
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6.7.6

Resetting to factory settings with WinCC flexible
CAUTION
Updating the operating system deletes all data on the HMI device
When you update the operating system you delete data on the target system. For this
reason, it is advisable to backup the following data:
• User administration
• Recipes
Resetting to factory settings also deletes the License Keys. You should also back up the
License Keys before resetting to factory settings.

Requirements
● No project is open on the configuring PC in WinCC flexible.
● The HMI device is connected to this configuring PC over the standard Ethernet cable.
● Have the MAC address of your HMI device's Ethernet interface to hand.
– The MAC address is displayed briefly when the HMI device is turned on.
– The MAC address is displayed in the "Profinet" dialog of the "Device" tab in the
Control Panel.

Procedure for setting the PC interface
1. Select "Start > Control Panel > Set PG / PC interface" on the configuring PC.
2. Select "S7ONLINE (STEP7) -> TCP / IP" from the "Application access point" area.
3. Select the interface which is connected to the HMI device from the "Interface
parameterization used" area.
4. Confirm your entries.

Procedure for resetting factory settings
Proceed as follows:
1. On the configuring PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.
The "Communication Settings" dialog opens.
2. Select the HMI device type from the "General" tab, and select "Ethernet" from the
"Connection" area.
3. Enter an IP address.
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Note
Possible address conflicts with incorrect IP address
Do not use a dynamic IP configuration for "Reset to factory settings".
Specify a unique IP address in which the configuring PC is located. For the duration of
the update process, the HMI device is automatically assigned to the specified address.
If the HMI device has already been used with WinCC flexible or ProSave you can use the
existing IP address for "Reset to factory settings".
4. Confirm your entries.
5. Select the "OS Update" command from the "Project > Transfer" menu in WinCC flexible.
6. Select the "Reset to factory settings" check box.
A text box opens where you can enter the MAC address.
7. Enter the HMI device's MAC address in the text box.
8. Select the HMI device image file "*.img" under "Image path".
The HMI device image files are available under "WinCC flexible Images" in the
WinCC flexible installation folder or on the WinCC flexible installation DVD.
The output area provides information on the version of the successfully opened HMI
device image file.
9. In WinCC flexible, select "Update OS" on the configuring PC to run the operating system
update.
10.Follow the instructions in WinCC flexible on the configuring PC.
A progress bar indicates the progress of the operating system update.

Result
A message is displayed when the operating system update is successfully completed.
The HMI device no longer contains any project data. The factory settings are reset.
Note
If you can no longer open the Control Panel on the HMI device because the operating
system is missing, carry out the above-described steps to reset the device to the factory
settings, and try again.
Note
Calibrating the touch screen
When the restore operation has been completed, you may have to recalibrate the touch
screen.
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6.7.7

Resetting to factory settings with ProSave

Requirement
● The HMI device is connected over the Ethernet to a PC on which ProSave is installed.
● Have the MAC address of your HMI device's Ethernet interface to hand.
– The MAC address is displayed briefly when the HMI device is turned on.
– Touch HMI devices: The MAC address is displayed in the "Profinet" dialog of the
"Device" tab in the Control Panel.
– KP300 Basic: The MAC address is displayed under "Info/Settings > Network Info".

Procedure for setting the PC interface
1. Select "Start > Control Panel > Set PG / PC interface" on the configuring PC.
2. Select "S7ONLINE (STEP7) -> TCP / IP" from the "Application access point" area.
3. Select the interface which is connected to the HMI device from the "Interface
parameterization used" area.
4. Confirm your entries.

Procedure for resetting factory settings
Proceed as follows:
1. Go to the Windows Start menu and start ProSave on the PC.
2. Select the HMI device type from the "General" tab, and select "Ethernet" from the
Connection area.
3. Enter an IP address.
Note
Possible address conflicts with incorrect IP address
Do not use a dynamic IP configuration for "Reset to factory settings".
Specify a unique IP address of the subnet in which the configuring PC is located. For the
duration of the update process, the HMI device is automatically assigned to the specified
address of ProSave.
If the HMI device has already been used with WinCC flexible or ProSave you can use the
existing IP address for "Reset to factory settings".
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4. Change to the "OS Update" tab.
5. Select the "Reset to factory settings" check box.
A text box opens where you can enter the MAC address.
6. Enter the HMI device's MAC address in the text box.
7. Select the HMI device image file "*.img" under "Image path".
The HMI device image files are available under "WinCC flexible Images" in the
WinCC flexible installation folder or on the WinCC flexible installation DVD.
The output area provides information on the version of the successfully opened HMI
device image file.
8. Select "Update OS" on the PC to start the "Reset to factory settings" process.
9. Follow the instructions in ProSave.
A progress bar indicates the progress of the operating system update.

Result
A message is displayed when the operating system update is successfully completed.
The HMI device no longer contains any project data. The factory settings are reset.
Note
If you can no longer open the Control Panel on the HMI device because the operating
system is missing, carry out the above-described steps to reset the device to the factory
settings, and try again.
Note
Calibrating the touch screen
When the restore operation has been completed, you may have to recalibrate the touch
screen.
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6.7.8

Resetting to factory settings with WinCC
If possible, you should use the interface with the highest bandwidth for this connection, such
as Ethernet. Updating the operating system via a serial connection can take up to an hour.
CAUTION
Updating the operating system deletes all data on the HMI device
When you update the operating system you delete data on the target system. For this
reason, it is advisable to backup the following data:
• User administration
• Recipes
Resetting to factory settings also deletes the License Keys. You should also back up the
License Keys before resetting to factory settings.
Note
The following is required to restore factory settings using Ethernet:
• MAC address of the HMI device
• Available IP address
• PG/PC interface of the configuring PC that is set to Ethernet TCP/IP
You configure the PG/PC interface using the Control Panel of the configuring PC. Select
"S7ONLINE (STEP7) -> TCP/IP" under "Application access point".

Requirements
● The HMI device is connected to the configuring PC
● The HMI device is selected in the project navigation.

Resetting the HMI device to factory settings
To reset the HMI device to factory settings, proceed as follows:
1. Switch off power to the HMI device.
2. Select the "Update operating system" command from the menu under "Online > HMI
device maintenance" on the configuring PC in WinCC.
The "SIMATIC ProSave [OS-Update]" dialog opens. The path to the image of the
operating system has been preset.
3. If necessary, select another path to the operating system image you want to transfer to
the HMI device.
4. Activate "Reset to factory settings".
5. Click "Update OS".
6. To "Reset to factory settings", switch on power to the HMI device again.
This operation can take time.

Result
The operating system of the HMI device is now updated to the current version.
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Maintenance and care

Introduction
The HMI device is designed for maintenance-free operation. Make sure you keep the touch
screen and keyboard membrane clean.

Requirements
Use a cleaning cloth dampened with a cleaning agent to clean the equipment. Only use
water with a little liquid soap or a screen cleaning foam.
NOTICE
Unintentional response
When cleaning the touch screen, an unintentional response in the PLC can be triggered by
touching keys.
Switch the HMI device off before cleaning to prevent unintentional responses.
Damage caused by unauthorized cleaning products
The HMI device may be damaged if compressed air, steam jet-air ejectors, aggressive
solvents or scouring powders are used for cleaning purposes.
Do not clean the HMI device with compressed air or steam jet blowers. Do not use
aggressive solvents or scouring powder.

Procedure
Proceed as follows:
1. Shut down the HMI device.
2. Spray the cleaning solution onto a cleaning cloth.
Do not spray directly onto the HMI device.
3. Clean the HMI device.
When cleaning the display wipe from the screen edge inwards.
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7.2

Recycling

Recycling and disposal
The HMI devices described in these operating instructions can be recycled due to the low
levels of pollutants. Contact a certified disposal service company for environmentally sound
recycling and disposal of your old devices.
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Certificates and approvals

Approvals
CAUTION
The following overview shows possible approvals.
The HMI device itself is certified as shown on the rear panel labels.

CE approval
The HMI device meets the general and safety-related requirements of the following EC
directives and conforms to the harmonized European standards (EN) for programmable logic
controllers published in the official gazettes of the European Union:
● 2004/108/EC "Electromagnetic Compatibility" (EMC Directive)
EC Declaration of Conformity
The EC Declarations of Conformity are available to the relevant authorities at the following
address:
Siemens AG
Industry Sector
I IA AS FA WF AMB
PO Box 1963
D-92209 Amberg, Germany

Marking for Australia
The HMI device fulfills the requirements of standard AS/NZS 2064 (Class A).

UL approval
Underwriters Laboratories Inc., to
● UL 508 (Industrial Control Equipment)
● CSA C22.2 No. 142 (Process Control Equipment)

IEC 61131
The HMI device fulfills requirements and criteria to IEC 61131-2, Programmable Logic
Controllers, Part 2: Operating resource requirements and tests.

Basic Panels
Operating Instructions, 04/2012, A5E02421799-03

117

Technical specifications
8.2 Directives and declarations

8.2

Directives and declarations

8.2.1

Electromagnetic compatibility

Introduction
The HMI device fulfills, among other things, the requirements of the EMC law pertaining to
the domestic European market.

EMC-compatible installation of the HMI device
The EMC-compliant installation of the HMI device and the application of interference-proof
cable is the basis for interference-free operation. The "Directives for interference-free
installation of PLCs" and the "PROFIBUS Networks" manual also apply for the installation of
the HMI device.

Pulse-shaped disturbance
The following table shows the electromagnetic compatibility of modules with regard to pulseshaped interference. The precondition for electromagnetic compatibility is that the HMI
device meets the specifications and guidelines for electrical installation.
Pulse-shaped disturbance

Tested with

Degree of
severity

Electrostatic discharge
in accordance with IEC
61000-4-2

Air discharge: 8 kV
Contact discharge: 6 kV

3

Burst pulses
(high-speed transient
interference)
in accordance with
IEC 61000-4-4

2 kV power supply cable
2 kV signal cable, > 30 m
1 kV signal cable, < 30 m

3

High-power surge pulses in accordance with IEC 61000-4-5, external protective circuit required (refer
to the manual Automation System S7-300, Installation, "Lightning and overvoltage protection"
section)
Asymmetrical coupling

2 kV power cable
DC voltage with protective elements

3

2 kV signal/data cable, > 30 m,
with protective elements as required
Symmetrical coupling

1 kV power cable
DC voltage with protective elements

3

1 KV signal cable, > 30 m, with protective elements as
required
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Sinusoidal interference
The following table shows the EMC behavior of the modules with respect to sinusoidal
interference. This requires the HMI device to meet the specifications and directives for
electrical installation.
Sinusoidal interference

Test values

HF radiation (in
electromagnetic fields) in
accordance with IEC 610004-3

•

80% amplitude modulation at 1 kHz
with 10 V/m in the range of 80 MHz to 1 GHz
with 3 V/m in the range 1.4 GHz to 2 GHz
with 1 V/m the range 2 GHz to 2.7 GHz

•

10 V/m with 50% pulse modulation at 900 MHz
10 V/m with 50% pulse modulation at 1.89 GHz

RF interference current on
cables and cable shielding
conforming to IEC 61000-4-6

Degree of
severity

Test voltage 10 V, with 80% amplitude modulation of 1
kHz in the 9 MHz to 80 MHz range

3

3

Emission of radio interference
The following table shows the unwanted emissions from electromagnetic fields in
accordance with EN 55011, Limit Value Class A, Group 1, measured at a distance of 10 m.
From 30 to 230 MHz

< 40 dB (μV/m) quasi-peak

From 230 to 1000 MHz

< 47 dB (μV/m) quasi-peak

Additional measures
To connect an HMI device to the public electric network, you must ensure its compliance
with Limit Value Class B to EN 55022.

8.2.2

ESD guideline

What does ESD mean?
An electronic module is equipped with highly integrated components. Due to their design,
electronic components are highly sensitive to overvoltage and thus to the discharge of static
electricity. Such electronic components or modules are labeled as electrostatic sensitive
devices.
The following abbreviations are commonly used for electrostatic sensitive devices:
● ESD – Electrostatic sensitive device
● ESD – Electrostatic Sensitive Device as a common international designation
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Electrostatic sensitive devices can be labeled with an appropriate symbol.
CAUTION
Damage to ESD from touch
Electrostatic sensitive devices, ESD, can be destroyed by voltages which are far below the
human perception limit. If you touch a component or electrical connections of a module
without discharging any electrostatic energy, these voltages may arise.
The damage to a module by an overvoltage can often not be immediately detected and only
becomes evident after an extended period of operation. The consequences are incalculable
and range from unforeseeable malfunctions to a total failure of the machine or plant.
Avoid touching components directly. Make sure that persons, the workstation and the
packaging are properly grounded.

Charge
Every person without a conductive connection to the electrical potential of his/her
surroundings can be electrostatically charged.

9ROWDJH

The material with which this person comes into contact is of particular significance. The
figure shows the maximum electrostatic voltages with which a person is charged, depending
on humidity and material. These values conform to the specifications of IEC 61000-4-2.
>N9@






















           >@
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①
②
③

Synthetic materials
Wool
Antistatic materials such as wood or concrete
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CAUTION
Grounding measures
There is no equipotential bonding without grounding. An electrostatic charge is not
discharged and may damage the ESD.
Protect yourself against discharge of static electricity. When working with electrostatic
sensitive devices, make sure that the person and the workplace are properly grounded.

Protective measures against discharge of static electricity
● Disconnect the power supply before you install or remove modules which are sensitive to
ESD.
● Pay attention to good grounding:
– When handling electrostatical sensitive devices, make sure that persons, the
workstation and devices, tools and packaging used are properly grounded. In this
manner, you avoid static discharge.
● Avoid direct contact:
– As a general rule, do not touch electrostatic sensitive devices, except in the case of
unavoidable maintenance work.
– Hold the modules at their edge so that you do not touch the connector pins or
conductor paths. In this way, the discharge energy does not reach and damage the
sensitive components.
– Discharge your body electrostatically before you take a measurement at a module. Do
so by touching grounded metallic parts. Always use grounded measuring instruments.
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8.3

Dimension drawings

8.3.1

Dimension drawing of the KP300 Basic mono PN
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Dimension drawing of the KP400 Basic color PN



8.3.2
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Dimension drawing of the KTP400 Basic mono PN
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Dimension drawing of the KTP400 Basic color PN



8.3.4
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8.3.5

Dimension drawing of the KTP600 Basic color DP
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8.3.6

Dimension drawing of the KTP600 Basic mono/color PN
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8.3.7

Dimension drawing of the KTP1000 Basic color DP

$OOGLPHQVLRQVLQPP













Basic Panels

128

Operating Instructions, 04/2012, A5E02421799-03

Technical specifications
8.3 Dimension drawings

8.3.8

Dimension drawing of the KTP1000 Basic color PN
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Dimension drawing of the TP1500 Basic color PN
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8.4

Specifications

8.4.1

Power supply
CAUTION
Safe electrical isolation
Use only 24 VDC power supply units with safe electrical isolation in accordance with IEC
60364-4-41 or HD 384.04.41 (VDE 0100, Part 410), e.g. to PELV standard.
The supply voltage must be within the specified voltage range. Otherwise, malfunction at
the HMI device cannot be ruled out.
Applies to non-isolated plant configurations:
Connect the connection for GND 24 V from the 24 V power supply output to equipotential
bonding for uniform reference potential. You should always select a central point of
termination.
The following table shows the permitted rated voltage and the corresponding tolerance
range.

8.4.2

Rated voltage

Tolerance range

+24 VDC

19.2 to 28.8 V (–20%, +20%)

KP300 Basic and KP400 Basic

Weight
Weight without packaging

KP300 Basic mono PN

KP400 Basic color PN

Approx. 250 g

Approx. 510 g

KP300 Basic mono PN

KP400 Basic color PN

Display
Type

LCD mono FSTN

LCD TFT

Active display area

87 x 31 mm (3.6")

95 x 53.8 mm (4.3")

240 x 80 pixels

480 x 272 pixels

Possible colors

4 (only backlighting:
white, red, green, yellow)

256

Contrast control

Yes

No

Brightness control

No

Yes

Resolution
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KP300 Basic mono PN
Backlighting
Half Brightness Life Time (MTBF 1)
Pixel error class according
to DIN EN ISO 13406-2

KP400 Basic color PN
LED
50,000 h

-

II

MTBF: Operating hours after which the maximum brightness is reduced by half compared to the original value. MTBF is
increased by using the integrated dimming function, for example, time-controlled via screen saver or centrally via
PROFIenergy.

1

Input device
KP300 Basic mono PN
Type

KP400 Basic color PN

Membrane keyboard

Function keys

10

8

Labeling strips

No

Yes

KP300 Basic mono PN

KP400 Basic color PN

512 KB

1024 KB

KP300 Basic mono PN

KP400 Basic color PN

Memory
Application memory

Interfaces
1 x Ethernet RJ45

10/100 Mbps

Supply voltage
KP300 Basic mono PN
Rated voltage

KP400 Basic color PN
+24 V DC

Range, permissible

19.2 to 28.8 V (–20%, +20%)

Transients, maximum permissible

35 V (500 ms)

Time between two transients,
minimum

50 s

Current consumption
•

Typical

Approx. 100 mA

Approx. 100 mA

•

Constant current, maximum

Approx. 150 mA

Approx. 120 mA

•

Inrush current I2t

A2s

Approx. 0.5 A2s

Approx. 0.5

Fuse, internal

Electronic

Miscellaneous
KP300 Basic mono PN
Software clock, synchronizable

KP400 Basic color PN
Yes
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8.4.3

KTP400 Basic and KTP600 Basic

Weight
KTP400 Basic
mono PN
Weight without packaging

KTP400 Basic
color PN

KTP600 Basic
mono PN

KTP600 Basic
color DP

KTP600 Basic
color PN

Approx. 320 g

Approx. 340 g

Approx. 1070 g

KTP400 Basic
mono PN

KTP400 Basic
color PN

KTP600 Basic
mono PN

LCD mono FSTN

LCD TFT

LCD mono FSTN

Active display area

76.8 x 57.6 mm
(3.8")

95 x 53.8 mm
(4.3")

115.2 mm x 86.4 mm
(5.7")

Resolution

320 x 240 pixels

480 x 272 pixels

320 x 240 pixels

Possible colors

4 grayscales

256

4 grayscales

256

Contrast control

Yes

No

Yes

No

No

Display

Type

Brightness control

KTP600 Basic
color PN

LCD TFT

No

Yes

LED

LED

CCFL

Half Brightness Life Time
(MTBF 1)

30,000 h

50,000 h

50,000 h

Pixel error class according
to DIN EN ISO 13406-2

-

II

Backlighting

1

KTP600 Basic
color DP

No

-

II

MTBF: Operating hours after which the maximum brightness is reduced by half compared to the original value. MTBF is
increased by using the integrated dimming function, for example, time-controlled via screen saver or centrally via
PROFIenergy.

Input device
KTP400 Basic
mono PN

KTP400 Basic
color PN

Type

KTP600 Basic
mono PN

KTP600 Basic
color DP

KTP600 Basic
color PN

Touch screen, analog resistive

Function keys

4

6

Labeling strips

Yes

Memory
KTP400 Basic
mono PN
Application memory

KTP400 Basic
color PN

KTP600 Basic
mono PN

KTP600 Basic
color DP

KTP600 Basic
color PN

512 KB
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Interfaces
KTP400 Basic
mono PN
1 x RS 422/RS 485

KTP400 Basic
color PN

KTP600 Basic
mono PN

-

-

-

1 x Ethernet RJ45

KTP600 Basic
color DP

KTP600 Basic
color PN

Max. 12 Mbps

10/100 Mbps

-

10/100 Mbps

Supply voltage
KTP400 Basic
mono PN

KTP400 Basic
color PN

Rated voltage

KTP600 Basic
mono PN

KTP600 Basic
color DP

KTP600 Basic
color PN

+24 V DC

Range, permissible

19.2 to 28.8 V (–20%, +20%)

Transients, maximum
permissible

35 V (500 ms)

Time between two
transients, minimum

50 s

Current consumption
•

Typical

Approx. 100 mA

Approx. 100 mA

Approx. 240 mA

Approx. 350 mA

•

Constant current,
maximum

Approx. 150 mA

Approx. 120 mA

Approx. 350 mA

Approx. 550 mA

Approx. 0.5 A2s

Approx. 0.5 A2s

Approx. 0.5 A2s

Approx. 0.5 A2s

•

I2 t

Inrush current

Fuse, internal

Electronic

Miscellaneous
KTP400 Basic mono PN
Software clock,
synchronizable

KTP600 Basic mono
PN

KTP600 Basic color
DP

KTP600 Basic color
PN

Yes
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8.4.4

KTP1000 Basic and TP1500 Basic

HMI device
KTP1000 Basic color DP
Weight without packaging

KTP1000 Basic color PN

TP1500 Basic color PN

Approx. 2.65 kg

Approx. 4.2 kg

Display
KTP1000 Basic color DP

KTP1000 Basic color PN

Type

LCD TFT

Display area, active

211.2 mm x 158.4 mm
(10.4")

304.1 mm x 228.1 mm
(15")

640 x 480

1024 x 768

Resolution, pixels

1

TP1500 Basic color PN

Colors, displayable

256

Brightness control

Yes

Pixel error class according
to DIN EN ISO 13406-2

II

Backlighting
Half Brightness Life Time
(MTBF 1)

CCFL
50,000 h

MTBF: Operating hours after which the maximum brightness is reduced by half compared to the original value. MTBF is
increased by using the integrated dimming function, for example, time-controlled via screen saver or centrally via
PROFIenergy.

Input device
KTP1000 Basic color DP
Type

KTP1000 Basic color PN

TP1500 Basic color PN

Touch screen, analog resistive

Function keys

8 function keys

No

Labeling strips

Yes

No

Memory
KTP1000 Basic color DP
Application memory

KTP1000 Basic color PN

TP1500 Basic color PN

1024 KB

Interfaces
KTP1000 Basic color DP
1 x RS 422/RS 485

KTP1000 Basic color PN

TP1500 Basic color PN

Max. 12 Mbps

-

-

RJ45 10/100 Mbps

1 x Ethernet
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Supply voltage
KTP1000 Basic color DP

KTP1000 Basic color PN

Rated voltage

TP1500 Basic color PN

+24 V DC

Range, permissible

19.2 to 28.8 V (–20%, +20%)

Transients, maximum permissible

35 V (500 ms)

Time between two transients,
minimum

50 s

Current consumption
•

Typical

Approx. 600 mA

Approx. 800 mA

•

Constant current, maximum

Approx. 1000 mA

Approx. 1000 mA

•

Inrush current I2t

Approx. 0.2 A2s

Approx. 0.2 A2s

Fuse, internal

Electronic

Miscellaneous
KTP1000 Basic color DP
Software clock, synchronizable

KTP1000 Basic color PN

TP1500 Basic color PN

Yes
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8.4.5

Ambient conditions

8.4.5.1

Transport and storage conditions

Mechanical and climatic conditions for transportation and storage
The transport and storage conditions of this HMI device exceed requirements in accordance
with IEC 61131-2. The following specifications apply to the transport and storage of an HMI
device in its original packaging.
The climatic conditions conform to the following standards:
● IEC 60721-3-3, Class 3K7 for storage
● IEC 60721-3-2, Class 2K4 for transport
Mechanical requirements conform to EC 60721-3-2, Class 2M2.
Type of condition

Permitted range

Drop test (in transport package)

≤1m

Temperature

From –20 to +60 °C

Atmospheric pressure

From 1080 hPa to 660 hPa,
corresponds to an elevation of -1000 to 3500 m

Relative humidity

From 10 % to 90 %, without condensation

Sinusoidal vibration in accordance with
IEC 60068-2-6

5 to 8.4 Hz: 3.5 mm
8.4 to 500 Hz: 9.8 m/s2

Shock conforming to IEC 60068-2-29

250 m/s2, 6 ms, 1000 shocks

NOTICE
Ensure that no condensation (dewing) develops on or inside the HMI device after
transporting it at low temperatures or after it has been exposed to extreme temperature
fluctuations.
The HMI device must have acquired room temperature before it is put into operation. Do
not expose the HMI device to direct radiation from a heater in order to warm it up. If dewing
has developed, wait approximately 4 hours until the HMI device has dried completely
before switching it on.
Proper transport and storage, installation and assembly as well as careful operation and
maintenance are required to ensure trouble-free and safe operation of the HMI device.
The warranty for the HMI device will be deemed void if these stipulations are not heeded.

See also
Notes about usage (Page 26)
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8.4.5.2

Conditions of use

Mechanical and climatic conditions of use
The HMI device is designed for use in a location protected from the effects of the weather.
The conditions of use are compliant with requirements to DIN IEC 60721-3-3:
● Class 3M3 (mechanical requirements)
● Class 3K3 (climatic requirements)

Use with additional measures
The HMI device should not be used at the following locations unless additional measures are
taken:
● In locations with a high degree of ionizing radiation
● In locations with difficult operating conditions - for example due to:
– Corrosive vapors, gases, oils or chemicals
– Electrical or magnetic fields of high intensity
● In plants that require special monitoring - for example:
– Elevators
– Systems in especially hazardous rooms

Mechanical ambient conditions
The mechanical ambient conditions for the HMI device are specified in the following table in
terms of sinusoidal vibration.
Frequency range in Hz

Constant

Occasional

10 ≤ f ≤ 58

Amplitude 0.0375 mm

Amplitude 0.075 mm

58 ≤ f ≤ 150

Constant acceleration 0.5 g

Constant acceleration 1 g

Reducing vibrations
If the HMI device is subjected to greater shocks or vibrations, you must take appropriate
measures to reduce acceleration or amplitudes.
We recommend fitting the HMI device to vibration-absorbent material (on metal shock
absorbers, for example).
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Testing mechanical ambient conditions
The following table provides information on the type and scope of tests for mechanical
ambient conditions.
Tested for

Test standard

Comments

Vibrations

Vibration test in accordance
with IEC 60068, part 2–6
(sinusoidal)

Type of vibration:
Transitional rate of the frequency:
1 octave/minute.
10 Hz ≤ f ≤ 58 Hz,
constant amplitude of 0.075 mm
58 Hz ≤ f ≤ 150 Hz,
constant acceleration 1 g
Vibration duration:
10 frequency cycles per axis at each of the three
associated vertical axes

Shock

Shock test in accordance
with IEC 60068, Part 2 –27

Type of shock: Half-sine
Shock intensity:
Peak value 15 g, duration 11 ms
Direction of impact:
3 shocks in ± direction at each one of the three
associated vertical axes

Climatic ambient conditions
The following table shows the climatic ambient conditions for operation of the HMI device.
Ambient conditions

Permitted range

Comments

Temperature
•

Vertical mounting

From 0 to 50° C

•

Mounting at an angle

From 0 to 40° C

Slope angle max. 35°

Relative humidity

10 to 90 %, without condensation

Atmospheric pressure

1080 to 795 hPa

Corresponds to an elevation of –
1,000 to 2,000 m

Pollutant concentration

SO2: < 0.5 ppm;
Relative humidity < 60%, no
condensation

Test: 10 cm3/m3; 10 days

H2S: < 0.1 ppm;
Relative humidity < 60%, no
condensation

Test: 1 cm3/m3; 10 days
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8.4.5.3

Information on insulation tests, protection class and degree of protection

Test voltages
Insulation strength is demonstrated in the type test with the following test voltages in
accordance with IEC 61131-2:
Circuits with a nominal voltage of Ue to other
circuits or ground

Test voltage

< 50 V

500 VDC

Protection class
Protection Class I in accordance with IEC 60536, i.e. PE/ground terminal to profile rail
required!

Protection against foreign objects and water
Degree of protection in accordance
with IEC 60529

Explanation

Front

When mounted:

Rear panel

•

IP65

•

Front face only Type 4X/Type 12 (indoor use only)

IP20
Touch protection test with standard test probes. There is no
protection against ingress by water.

The degree of protection at the front can only be guaranteed if the mounting seal is installed
flush to the mounting cut-out. Read the corresponding information in section "Making the
mounting cut-out".

See also
Making the mounting cut-out (Page 31)
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8.5

Interface description

8.5.1

Power supply
Plug connector, 2-pin




Pin number

8.5.2

Assignment

1

+24 VDC (L+)

2

GND 24 V (M)

PROFIBUS (Sub-D RS422/485)
Name of interface on HMI device: X2
Sub-D socket, 9-pin, with screw lock








Pin

Assignment for the RS 422

Assignment for the RS 485

1

n. c.

n. c.

2

GND 24 V

GND 24 V

3

TxD+

Data channel B (+)

4

RD+

RTS

5

GND 5 V, floating

GND 5 V, floating

6

+5 VDC, floating

+5 VDC, floating

7

+24 VDC, out (max. 100 mA)

+24 VDC, out (max. 100 mA)

8

TxD–

Data channel A (–)

9

RxD–

NC
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8.5.3

PROFINET (Ethernet)
Name of interface on HMI device: X1
RJ45 plug connector





Pin

Assignment

1

Tx+

2

Tx–

3

Rx+

4

n. c.

5

n. c.

6

Rx–

7

n. c.

8

n. c.

Meaning of LEDs
State

Green "SPEED" LED

Yellow "LINK" LED

On 1

Off

No connection

1

10 MB connection

Off

On

100 MB connection

On

On

Active data transfer 10 MB

Off

Flashing

Active data transfer 100 MB

On

Flashing

For KTP1000 Basic and TP1500 Basic: Off
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8.6

Functional scope with WinCC flexible and WinCC
The following tables show the objects that can be integrated in a project for a Basic Panel.

Alarms
Object

Specification

Basic Panels

Alarms

Number of discrete alarms

200

Number of analog alarms

15

Length of the alarm text

80 characters

Number of tags in an alarm

Max. 8

Display

Alarm window, alarm view

Acknowledge error alarm individually

Yes

Acknowledge multiple error alarms simultaneously
(group acknowledgement)

16 acknowledgment
groups

Edit alarm

Yes

Alarm indicator
Alarm buffer

Yes

Alarm buffer capacity

256 alarms

Simultaneously queued alarm events

Max. 64

View alarm

Yes

Delete alarm buffer

Yes

Tags, values and lists
Object

Specification

KP300 Basic mono PN

KP400 Basic color PN

KTP400 Basic mono PN

KTP400 Basic color PN
KTP600 Basic mono PN
KTP600 Basic color DP/PN
KTP1000 Basic color DP/PN
TP1500 Basic color PN

Tags

Quantity

250

500

Limit value monitoring

Input/output

Yes

Linear scaling

Input/output

Yes

Text lists

Quantity

150

Screens
Object

Specification

Screens

Quantity

50

Fields per screen

30

Tags per screen

30

Complex objects per screen (for example, bars)

5

Template

Basic Panels

Yes
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Recipes
The specified values are maximum values and should not be used additive.
Object

Specification

Recipes

Quantity

Basic Panels
5

Elements per recipe

20

Data records per recipe

20

Safety
Object

Specification

Basic Panels

Safety

Number of user groups

50

Number of users

50

Number of authorizations

32

Infotexts
Object

Specification

Basic Panels

Infotexts

Length (no. of characters)

320

For alarms

Yes

For screens

Yes

For screen objects (for example, for I/O field, switch, button,
invisible button)

Yes

Additional functions
Object

Specification

Screen settings

Touch screen calibration
Brightness setting
Contrast setting

Basic Panels mono
Yes

Basic Panels color
Yes 1

1

-

Yes 2

Yes

-

Language change

Number of languages

5

Graphic objects

Vector and pixel graphics

Trend views

Quantity

max. 25

Trends per view

Quantity

max. 4

Text objects

Quantity

500

Yes

1

Not KP300 Basic mono PN and KP400 Basic color PN

2

Not KTP600 Basic mono PN, KTP600 Basic color PN, KTP600 Basic color DP
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New system functions
In addition to the system functions already available, WinCC flexible 2008 SP2 and WinCC
V11 or higher support the following system functions for the Basic Panels:

1

System function/syntax

Application

SetBitInTag (Tag, Bit)

Sets a bit in the specified tag to 1 (TRUE).

ReSetBitInTag (Tag, Bit)

Sets a bit in the specified tag to 0 (FALSE).

InvertBitInTag (Tag, Bit)

Inverts a bit in the specified tag.

SetColorBackgroundLighting (value) 1)

Specifies the color for the backlighting.

KP300 Basic mono PN only

For more information, refer to "System functions" in the the Online Help of WinCC flexible
and WinCC.
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A.1

A

Service and support
You can find additional information and support for the products described on the Internet at
the following addresses:
● Technical support
(http://www.siemens.de/automation/csi_en_WW)
● Support request form
(http://www.siemens.com/automation/support-request)
● After-sales information system for SIMATIC PC / PG
(http://www.siemens.com/asis)
● SIMATIC Documentation Collection
(http://www.siemens.com/simatic-tech-doku-portal)
● Your local representative
(http://www.automation.siemens.com/mcms/aspa-db/en/Pages/default.aspx)
● Training center
(http://sitrain.automation.siemens.com/sitrainworld/?AppLang=en)
● Industry Mall
(http://mall.automation.siemens.com)
When contacting your local representative or Technical Support, please have the following
information at hand:
● Order number of the device (MLFB)
● BIOS version (industry PC) or image version (HMI device)
● Installed additional hardware
● Installed additional software

Tools & downloads
Please check regularly if updates and hotfixes are available for download to your device. The
downloads are available on the Internet under "After Sales Information System SIMATIC
PC/PG" (see above).
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Technical Support
A.2 System events

A.2

System events
System events on the HMI device provide information about internal states of the HMI device
and PLC.
Note
System events are only indicated if an alarm window was configured. System events are
output in the language currently set on your HMI device.
System event parameters
System events may contain encrypted parameters which are relevant to troubleshooting
because they provide a reference to the source code of the runtime software. These
parameters are output after the text "Error code:"

Description of the system events
A listing of all system alarms for your HMI device is provided in the Online Help of your
configuration software.
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Abbreviations
ANSI

American National Standards Institution

CPU

Central Processing Unit

CSV

Comma Separated Values

CTS

Clear To Send

DC

Direct Current

DCD

Data Carrier Detect

DHCP

Dynamic Host Configuration Protocol

DIL

Dual-in-Line (electronic chip housing design)

DNS

Domain Name System

DP

Distributed I/O

DSN

Data Source Name

DSR

Data Set Ready

DTR

Data Terminal Ready

IO

Input and Output

ESD

Components and modules endangered by electrostatic discharge

EMC

Electromagnetic Compatibility

EN

European standard

ES

Engineering System

ESD

Components and modules endangered by electrostatic discharge

GND

Ground

HF

High Frequency

HMI

Human Machine Interface

IEC

International Electronic Commission

IF

Interface

IP

Internet Protocol

LED

Light Emitting Diode

MAC

Media Access Control

MOS

Metal Oxide Semiconductor

MPI

Multipoint Interface (SIMATIC S7)

MS

Microsoft

MTBF

Mean Time Between Failures

n. c.

Not connected

NTP

Network Time Protocol

OP

Operator Panel

PC

Personal Computer

PG

Programming device

PPI

Point-to-Point Interface (SIMATIC S7)

RAM

Random Access Memory
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Abbreviations

PELV

Protective Extra Low Voltage

RJ45

Registered Jack Type 45

RTS

Request to send

RxD

Receive Data

SD Card

Security Digital Card

SELV

Safety Extra Low Voltage

SP

Service Pack

PLC

Programmable Logic Controller

STN

Super Twisted Nematic

Sub-D

Subminiature D (plug)

TAB

Tabulator

TCP/IP

Transmission Control Protocol/Internet Protocol

TFT

Thin Film Transistor

TTY

Teletype

TxD

Transmit Data

UL

Underwriter’s Laboratory

USB

Universal Serial Bus

UPS

Uninterruptible power supply

WINS

Windows Internet Naming Service
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Glossary
"Transfer" mode
HMI device operating mode for transferring an executable project from the configuring PC to
an HMI device.

Acknowledge
Acknowledgment of an alarm confirms that it has been noted.

Alarm, acknowledgment
Acknowledgment of an alarm confirms that it has been noted.

Alarm, activated
Moment at which an alarm is triggered by the PLC or HMI device.

Alarm, deactivated
Moment at which the initiation of an alarm is reset by the PLC.

Alarm, user-specific
User-specific alarms report specific states of a plant that is interconnected with the HMI
device via the PLC.

Automation system
An automation system is a PLC of the SIMATIC S7 product line, e.g. SIMATIC S7-300

Boot loader
The boot loader is used to start the operating system and is started automatically after power
on of the HMI device. The Loader is displayed after the operating system has loaded.

Configuration software
The configuration software is used to create projects for process visualization.
WinCC flexible is such a configuration software, for example.
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Glossary

Configuring PC
A configuring PC is a programming device or PC on which plant projects are created using
an engineering software.

Display duration
Defines whether a system alarm is displayed on the HMI device and the duration of the
display.

EMC
Electromagnetic compatibility is the ability of electrical equipment to function properly in its
electromagnetic environment without influencing this environment.

Event
Incoming events trigger defined functions. Events can be configured. Events which can be
assigned to a button include "Press" and "Release", for example.

Field
Area reserved in configured screens for the input and output of values.

Flash memory
Flash memory is a non-volatile memory with EEPROM chips that is implemented either as
mobile storage medium, or as permanently installed memory module on the motherboard.

Function key
Function keys on the HMI device can be assigned user-specific functions. The functions
assigned to those keys are defined in the engineering phase. The function key assignment
can be specific to an active screen or not.

Half Brightness Life Time
Time period after which brightness is reduced to 50% of the original value. The specified
value depends on the operating temperature.

HMI device
HMI devices are used to operate and monitor machinery and plants. The machine or plant
states are visualized on the HMI device by means of graphic objects or signal lamps. The
operator controls of the HMI device enable intervention in machine or plant processes and
sequences.
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Glossary

HMI device image
The HMI device image is a file that can be transferred from the configuring PC to the HMI
device. The HMI device image contains the operating system of the HMI device , including
the elements of the Runtime software required for the executable project file.

I/O field
Enables the input or output of values on the HMI device and their transfer to the PLC.

Infotext
A configured infotext provides information about objects within a project. An alarm infotext,
for example, can contain information on the cause and troubleshooting of faults.

Object
An object is a project element such as a screen or an alarm. Objects are used to view or
enter texts and values on the HMI device.

Operating element
An operating element is a project component that is used to enter values and trigger
functions. A button is such an operating element.

Plant
General term referring to machinery, processing centers, systems, plants and processes
which are operated and monitored using an HMI device.

PLC
PLC is a general term for devices and systems with which the HMI device communicates,
e.g. SIMATIC S7.

PLC job
A PLC job triggers a function at the HMI device.

Process visualization
Denotes visualization of technical processes by means of text and graphic elements.
Configured plant screens enable intervention in runtime plant processes by means of data
input and output.
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Glossary

Project
A project is the result of a configuration using an engineering software. The project usually
contains several screens with embedded system-specific objects, basic settings and alarms.
A project configured in WinCC flexible is saved to a project file with the extension *.hmi.
There is a difference between an offline project on a configuring PC and an online
executable project on an HMI device. A project can be available in more languages on the
configuring PC than can be managed on the HMI device. The project on the configuring PC
can also be set up for different HMI devices. However, on the HMI device you can only
transfer the executable project that has been generated specifically for this HMI device.

Project file
Source file from which the executable project file for the HMI device is generated. The
project file is usually not transferred and is retained on the configuring PC.

Project file, compressed
Compressed format of the project file. The compressed project file can be transferred in
addition to the executable project file to the corresponding HMI device. The upload function
must be activated accordingly on the configuring PC at the time of the transfer. The
compressed project file is usually saved to an external memory card.
A compressed project file has the extension *.pdz.

Project file, executable
An executable project file is generated from the project file for a specific HMI device in the
course of engineering. The executable project file is transferred to the associated HMI device
where it is used to operate and monitor plants.

ProSave
ProSave provides all functions necessary to transfer data between the configuring PC and
the HMI device. For example, saving and restoring data or managing license keys and addons.
ProSave is installed by default together with WinCC flexible or WinCC. The standalone
version of ProSave can also be used for service purposes on a PC without WinCC flexible
installation. The standalone version is available on the installation DVD of WinCC flexible.

Recipe
A recipe represent a combination of tags that form a fixed data structure. The configured
data structure can be assigned data in the configuration software or on the HMI device and
is then referred to as a data record. The use of recipes ensures that all data assigned to a
data record is transferred synchronously to the PLC.
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Runtime software
The Runtime software is a process visualization software which can be used to test projects
on a configuring PC.

Screen
Mode of visualization of all logically associated process data of a plant. Visualization of the
process data can be supported by means of graphic objects.

Screen object
Refers to objects such as rectangles, I/O fields, or alarm views which are configured for
visualization or operation of the plant.

STEP 7
STEP 7 is the programming software for SIMATIC S7, SIMATIC C7 and SIMATIC WinAC
PLCs.

STEP 7 Micro/WIN
STEP 7 Micro/WIN is the programming software for SIMATIC S7-200 PLCs.

Symbolic I/O field
Symbolic I/O fields are used for the input and output of values. A field contains a list of
default entries from which one can be selected.

System alarms
System alarms are assigned the "System" alarm class. A system alarm reports internal
states of the HMI device and of the PLC.

Tab order
The tab order defined in the course of project engineering determines the sequence for
activating objects by pressing the <TAB> key.

Tags
A tag is a defined memory area that is used to read and write values. Those tags can be
accessed from the PLC or using the HMI device. We distinguish between external tags
(process tags) and internal tags, depending on whether or not the tag is interconnected with
the PLC.
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Glossary

Transfer
Transfer of an executable project from the configuring PC to the HMI device.

WinCC
WinCC (TIA Portal) is engineering software for configuring SIMATIC Panels, SIMATIC
Industrial PC and standard PC with the visualization software WinCC Runtime Advanced or
the SCADA system, WinCC Runtime Professional.
A project created with WinCC has the file extension "*.ap11". An executable project file on a
HMI device has the extension "*.fwx".

WinCC flexible
WinCC flexible is an engineering software for configuring SIMATIC Panels, SIMATIC
Industrial PC and Standard PC in machine-related areas with the visualization software
WinCC flexible Runtime.
A project created with WinCC flexible has the file extension "*.hmi". An executable project
file on a HMI device has the extension "*.fwx".
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Index

A
ACK key, 65
Acknowledge key, 65
Activating
Automatic transfer, 84
Ambient conditions
Climatic, 139
Mechanical, 138
Test, 139
Approval for Australia, 117
Approvals, 117
Automatic transfer
Activating, 84

B
Backspace key, 64
Backup, 91, 96, 97, 99
Data of the HMI device, 100
With ProSave, 99
with WinCC, 100
With WinCC flexible, 97
Basic knowledge
Required, 4

C
Cancel key, 64
Care, 115
CE approval, 117
Checking
Conditions of use, 138
Electromagnetic Compatibility, 118
Package content, 29
Standards and approvals, 117
Transport and storage conditions, 137
Clamping frame, 23
Climatic
Storage conditions, 137
Transport conditions, 137

Clock
KP300 Basic, 132
KTP1000 Basic, TP1500 Basic, 136
KTP400 Basic, KTP600 Basic, 134
Commissioning engineers, 3
Compatibility conflict, 96
Components sensitive to electrostatic charge, 119
Conductor cross-section
Equipotential bonding, 38
Configuration phase, 89
Configuring
MPI/Profibus Settings, 69
Network settings, 70
RS422/RS485 port, 46
Time server, 71, 86
Configuring PC, 89
Connecting
Configuring PC, 42
Equipotential bonding, 38
PLC, 45
Power supply, 40
Programming device, 41
Control cabinet
Working on, 25
Control Panel
Menu structure, 81
Opening, 67
Overview, 68, 81
Password protection, 68, 80
Cursor key, 64

D
Data channel
Enabling, 84
Locking, 84
Decimal places, 56, 58, 63
Degree of protection
Protection against ingress of solid foreign
bodies, 140
Protection against water, 140
Delete key, 64
DIP switch
Setting, 46
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Index

Display
KP300 Basic, 131
KTP1000 Basic, TP1500 Basic, 135
KTP400 Basic, KTP600 Basic, 133
Disposal, 116
Disturbance
Pulse-shaped, 118
Sinusoidal, 119

E
EC Declaration of Conformity, 117
Elbow adapter, 23
Electrical isolation, 131
Electrical potential difference, 38
EMC directive, 117
Emission, 26, 119
Enabling
Data channel, 84
Enabling a data channel, 68
END key, 64
Enter key, 64
ENTER key, 64
Equipotential bonding
Cable, 38
Connecting, 38
Requirements, 38
Wiring diagram, 39
ESC key, 64
ESD, 119
ESD guidelines, 119

F
Factory setting
With ProSave, 112
with WinCC, 114
With WinCC flexible, 110
Figures, 5

Functional scope
Alarm buffer, 143
Alarms, 143
Graphic objects, 144
Infotext, 144
Language change, 144
Limit value monitoring, 143
Recipes, 144
Safety, 144
Scaling, 143
Screen settings, 144
Screens, 143
Tags, 143
Text lists, 143
Text objects, 144
Trend views, 144

G
Guidelines
ESD guidelines, 119

H
High frequency radiation, 25
HMI device
Connecting, 36
Data backup, 100
EMC-compatible installation, 118
Mounting, 34
Restoring data, 101
Shutting down, 49
Switching on, 48
Technical specifications, 131, 133, 135
Testing, 48
Updating the operating system, 109
HOME key, 64

I
Illustrations, 5
Infotext
Key, 65
Initial startup, 89
Input device
KP300 Basic, 132
KTP1000 Basic, TP1500 Basic, 135
KTP400 Basic, KTP600 Basic, 133
Installation as intended, 25
Insulation test, 140
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Interfaces
KP300 Basic, 132
KTP1000 Basic, TP1500 Basic, 135
KTP400 Basic, KTP600 Basic, 134
IT Security, 26

K
Key
ACK, 65
Cancel, 64
Cursor, 64
Delete, 64
END, 64
ENTER, 64
ESC, 64
HOME, 64
Infotext, 65
Scroll back, 64
Scroll forward, 64
SHIFT, 64
Switching, 64

L
Labeling
Approvals, 117
EC Declaration of Conformity, 117
Limit value check, 56, 58, 62
List of abbreviations, 149
Locking
Data channel, 84

M
Maintenance, 115
Maintenance technicians, 3
Mechanical
Ambient conditions, 138
Storage conditions, 137
Transport conditions, 137
Memory
KP300 Basic, 132
KTP1000 Basic, TP1500 Basic, 135
KTP400 Basic, KTP600 Basic, 133
Mounting
EMC-compatible, 118
HMI device, 34

Mounting clamp
Aluminum, 35
Plastic, 36
MPI/Profibus Settings, 68

N
Non-isolated plant configuration, 131

O
Offline
Operating mode, 90
Test, 95
Online
Operating mode, 90
Test, 96
OP properties
Device, 68
Display, 68
License, 68
Touch, 68
Operating
Control Panel with system keys, 65
Dialog with system keys, 65
Keyboard unit, 63
Project with system keys, 65
Operating instructions
Purpose of, 3
Scope, conventions, 4
Operating mode, 90
Changing, 90
Offline, 90
Online, 90
Transfer, 90
Operating system
Update using ProSave, 104, 108
Update using WinCC flexible, 103
Updating, 101, 105
Updating using WinCC flexible, 107
Operators, 3
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Index

P

S

Package content
Checking, 29
Password properties, 68
Password protection, 68, 80
Activating, 78, 87
Deactivating, 78, 87
PELV, 131
Plant configuration
Non-isolated, 131
PLC
Configuring the interface, 46
Power failure, 96
Process control phase, 89
PROFIBUS connector, 23
PROFINET connector, 23
Profinet Settings, 68
Project
Offline testing, 95
Testing online, 96
Transferring, 89
Protection class, 140
Protective foil, 24
Protective measure
Static electricity, 121

Safe electrical isolation, 131
Safety
Standards, 117
Safety instruction
Compatibility conflict, 96
Data channel, 102, 106
Data loss, 101, 105
Equipotential bonding cable, 38
General, 26
High frequency radiation, 25
Operation indoors, 26
Power failure, 96
Preventing inadvertent operation, 115
Storage, 137
Transport, 137
unauthorized cleaning products, 115
Unintentional response, 115
Working on the control cabinet, 25
Safety regulations, 25
Screen keyboard
Alphanumerical, 55, 57
Key assignment, 55, 57
KTP400 Basic, 54
KTP600 Basic, KTP1000 Basic, TP1500 Basic, 57
Numerical, 56, 58
Screen saver, 68
Screen settings
Editing, 68
Scroll back key, 64
Scroll forward key, 64
Securing device
with aluminum mounting clamps, 35
with plastic mounting clamps, 36
Security information, 26
Service packages, 24
Service technicians, 3
Shift key, 64
SHIFT key, 64
Shutting down
HMI device, 49
Sound Settings, 68
Spare part
Plastic clamp, 24
Power supply terminal, 24
Static electricity
Protective measures, 121

R
Radiation
High frequency, 25
Radio interference, 26
Emission, 119
Rated voltage, 131
Recommissioning, 89
Recycling, 116
Registered trademarks, 6
Regulations for the prevention of accidents, 25
Restore, 91, 96, 100
With ProSave, 100
Restoring, 98
Data of the HMI device, 101
with WinCC, 101
With WinCC flexible, 98
Restoring data
HMI device, 101
RS 422 to RS 232 converter, 23
RS422/RS485 port
Configuring, 46
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Storage conditions, 137
Strain relief, 50
Stripping, 39
Supply voltage
KP300 Basic, 132
KTP1000 Basic, TP1500 Basic, 136
KTP400 Basic, KTP600 Basic, 134
Switching on
HMI device, 48
System events
in the online help, 148
Parameters, 148
System keys
Operating a dialog, 65
Operating a project, 65
Operating the Control Panel, 65

U
UL approval, 117
Update
Using WinCC flexible, 103
Updating
Operating system, 101, 105
Operating system of the HMI device, 109
Using ProSave, 104, 108
Using WinCC flexible, 107
with WinCC, 109
Usage
Conditions, 138
With additional measures, 138
USB/PPI cable, 23
Use
In residential areas, 26
Industrial, 26

T
Technical specifications
Display, 131, 133, 135
Input device, 132, 133, 135
Interfaces, 132, 134, 135
Memory, 132, 133, 135
Supply voltage, 132, 134, 136
Test
Power supply, 131
Testing
HMI device, 48
Time server
Configuring, 86
Time Server Configuration, 68
Trademarks, 6
Transfer, 89, 90, 91
Automatic, 93
Manual, 91
Transfer settings, 68
Transferring
Project, 89
Transport conditions, 137

V
Vibrations, 138

W
Weight
KP300 Basic, 131
KTP1000 Basic, TP1500 Basic, 135
KTP400 Basic, KTP600 Basic, 133
Working on the control cabinet, 25
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